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PURPOSE:

To reduce the possible contamination in the pre-amplification laboratory that
could occur: (i) between the analyst and the samples (ii) from one sample to
another, or (iii) from extraneous sources of DNA within the laboratory.

PROCEDURES:
All gowning must be done before entering the pre-amplification room
Gloves, without exception, must always be worn while in the pre-amplification room.

2.

Masks and/or face shields must be worn by visitors when an analyst is working on samples.

3.

Any analyst working on samples must gown up with a full lab coat, gloves, and a mask
and/or face shield. Eye protection is at the discretion of the analyst. Lab coats can be
reused for a period of one week. Afterwards they should be thrown out. Masks/ face
shields can also be reused for a period of one week. Goggles can be exposed to UV light in
the Stratalinker to extend their life.

4.

When working in the pre-amplification laboratory, gloves must be rinsed in 10% bleach
before each procedure and in-between the handling of separate samples.

5.

Pipette stems must be wiped down with 10% bleach before each procedure, and in-between
the pipetting of separate samples.

6.

All hoods must be wiped down with 10% bleach before and after each procedure, and UV
light, if available, should be applied for 30 minutes before and following each procedure.

7.

All racks, tube-openers and any other plastic implements (but not the pipettes) must be
exposed to UV light in the Stratalinker for a minimum of 30 minutes before they can be
used.

8.

Any 96-well tube racks and covers taken to the 9700 room in post-amp must be exposed to
UV light in the Stratalinker for a minimum of 1 hour.

9.

All centrifuge tubes used in the laboratory will be removed from original packaging just
prior to the extraction, and only with bleached and dried gloves while fully gowned.

10.

At the end of each week, the counters, sinks, refrigerator/freezer handles and door handles
inside the laboratory and door handles inside the gowning room should be wiped down
with 10% bleach and the UV light on top of the fridge should be turned on.
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Nomenclature
1.

All normal samples will be labeled using the standard naming conventions
throughout the sample processing. At the 3100 run step, all samples must be
labeled according to which primer is associated with each sample. (e.g., “Sample
1B4” for primer B4)

2.

All samples re-extracted for the purposes of duplication should be labeled as
“dup” to separately identify the re-extraction sample from the original, and this
label should permanently be applied to these duplication samples (e.g., “Sample1
dupA4” for the duplicated sample cycle sequenced with primer A4)

3.

All sample that are re-injected from one 3100 run to the next, with no additional
cycle sequencing of that sample, should be labeled “reinj” for re-injection. This
label will separately identify the re-injected sample from the original sample.
(e.g.- “Sample 1dup-D2reinj” for the duplicated sample, cycle sequenced with
primer D2 and re-injected on the 3100 run)

4.

All samples that are re-cycle sequenced in order to confirm length heteroplasmy
should be labeled “conf” to separately identify the re-cycle sequenced sample
from the original, (e.g., “Sample 1A1conf” for the sample re-cycle sequenced
with primer A1)

5.

All samples that are reamplified or re-cycle sequenced in order to improve on the
quality of the results should be labeled “reamp” for reamplification.
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A.

GUIDELINES FOR SAMPLES

Repeat Analysis of Samples

Repeat testing of a sample can start at different stages, as listed below and appropriate
controls must be used.
1.

Extraction stage: A fresh extraction negative control must be run.

2.

Amplification stage: A new amplification negative control and HL60 positive
control must be included in the re-amplification. The extraction negative control
does not need to be repeated if the first test was valid and the extraction negative
control was negative.
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Cycle sequencing: A new amplification negative control must be tested for each
primer used; the original extraction and amplification controls do not have to be
repeated (eg., 20 ul of TE-4 may be used). Note: A separate positive control and
amplification negative control must be run for each primer that is being run
with the sample DNA.

4.

Reinjections: A positive control must be added to any reinjection set to act as a
run control. Any previously successful positive control sample may be used. No
negative controls need to be repeated for reinjections of previously prepared
samples, if the controls passed on the first run.

Batching and Duplication Guidelines
1.

2.
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3.

Evidence samples
a.

There will be no batching of evidence samples at the DNA extraction
stage (eg., each sample will have its own extraction negative control).
Therefore, no duplication of evidence samples will be done at the
extraction level.

b.

Batching of evidence samples is allowed at all steps following DNA
extraction but only within a given case (e.g., all hair samples from a single
case may be amplified on one sheet, but only for that one case.)

Exemplar samples

Batching of exemplar samples within a given case or from different cases will be
allowed at all steps of mtDNA analysis including the DNA extraction stage.
3.

General
a.

With two exceptions, evidence and exemplar samples must always be run
separately in time and/or space. As with nuclear DNA samples, batching
of evidence and exemplar samples is allowed during the DNA
Quantitation step. Batching of evidence and exemplar samples is also
allowed during product gel analysis provided that sample aliquots are done
on each sample type (evidence or exemplar) at separate times.
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Duplication of samples is only necessary when samples are batched.
Situations may exist when a sample is run separately throughout all testing
procedures. This sample does not need to be duplicated.

c.

Duplication of a given sample is accomplished by running one informative
primer for that sample in either HVI or HVII.

d.

Consult the table below for how to proceed given the following test
conditions:
Inclusion (concordance)
Exclusion
Repeat from step that
No retesting necessary
sample was batched. *
Repeat from step that
No retesting necessary
sample was batched. *
Repeat from step that
Repeat from step that
sample was batched
sample was batched unless
unless sample matches
Evidence
sample matches another
another sample collected
sample collected from the
from the same piece of
same piece of evidence.
evidence.
*Quantiblots and product gels are excluded from the duplication process.
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Sample type
Suspect
exemplar
Victim
exemplar
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Refer to the current Protocols for Forensic STR Analysis manual for the following
procedures:
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DNA Extraction
DNA extraction guidelines
Chelex DNA extraction from blood and buccal swabs
Chelex DNA extraction from soft tissue
Organic Extraction Procedure
Bone preparation and milling
Incubation for liquid and dry blood, bone marrow and tissue samples
Incubation for bone, teeth, and paraffin embedded tissue samples
Phenol Chloroform Extraction and Microcon clean-up
Preparation of Phase Lock Gel (PLG) tubes
Microcon 100 DNA concentration and purification

Estimation of DNA Quantity from QuantiBlot Analysis
Sample Blotting
Hybridization
Color Development
Photography
Quality Control & Troubleshooting
QuantiBlot Interpretation
Modified QuantiBlot starting with extracts in microtiter plates
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PURPOSE:

For documentation of hairs, bones, teeth, and other evidentiary items that will be
altered in the process of mitochondrial DNA testing.

PROCEDURE:
Make sure the computer is on and all of the proper cables are connected between the
Firewire camera and the computer.

2.

Double-click on the desktop shortcut EZDocPlus.

3.

Enter in your username and password. When the next screen appears, select the user role
based on the following guidelines:
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1.

ERT (Evidence Recovery Technician) – for logging in digital images of items
for a specific case.

b.

Scientist – For creating a database for a case, and logging in digital images of
items from that case.

c.

Administrator – for reviewing images from ERTs and scientists and creating
new users

Ar
D ch
oc iv
um ed
en 07
t C /24
on /2
tro 01
lC 0
oo
r

a.

NOTE:

The Administrator cannot create case databases, nor can they save case
images. To create a database and login images, select “Scientist.”

4.

As a Scientist, the next screen to appear will allow you to bring up previously entered
cases or create a new case. To recall a previous case, use the Case ID drop-down list and
select the case. Then select any of the images from that case from the Evidence ID dropdown list. To create a new case, click the New button.

5.

For a new case, enter the Case ID Number and the Evidence ID Number and click OK.

6.

The next screen to appear is the main program screen. Click on the
Blue Microcam button to access the Microcam Control Panel.

7.

Make sure at this point that the stereo microscope is on, and that the light source is active
and the specimen is in focus. When viewing solid, dark objects, it is best to use the
ocular light ring to illuminate the sample. When viewing slides or thin tissue samples,
use the direct light from the lamp base of the microscope.
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On the Microcam Control Panel (shown to the right),
perform the following:
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a. Click the Live button.
b. Adjust the binning so that the setting is 3 for both the
horizontal and vertical.
c. Check the Flip Image box.
d. Click the Auto Exposure button.
e. Adjust the intensity of the light and click Auto
Exposure if the image is too bright or too dark.

r

8.

MIDEO MACRO/MICROSCOPIC DIGITAL IMAGING SYSTEM

Ar
D ch
oc iv
um ed
en 07
t C /24
on /2
tro 01
lC 0
oo
r

NOTE: if the background color is not white or off
white, place a sheet of paper in view of the lens and
click on the White Balance button. Repeat step 8
once completed.
9.

Once the image on the screen is in focus and the proper contrast, click the Grab button
on the control panel. This will freeze the image on the screen.

10.

Under the Tools menu, select Overlays. Once the
panel opens up, perform the following:

a. Click on the Measure tab.
b. Click the Load Calibration button.
c. Select the calibration based on the current
microscope magnification level.
d. FOR LINEAR OBJECTS
1) Click on the Length button.
2) Select any of the length tools to measure the
length of the imaged object.
e. FOR NON-LINEAR OBJECTS
1) Click on the Multilength button
2) Trace the non-linear object length by rightclicking the mouse at desired turns and
corners. Hit “Enter” on the keyboard when
finished.
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Click on the Overlay Tools tab on the window. Once the panel opens, perform the
following:
a. Click on the Text button.
b. Click anywhere inside the image, and add in
the text box for an image label.
c. Click OK on the Overlay window.

12.

Save the image name by clicking on the
floppy-disk icon in the main window,
or by going to the File menu and select
Save.

13.

As a scientist, input the image name and
description, and click OK.

14.

To open a file once it’s saved, go to the File menu
and select DB Images. Find the case in which the
image is stored, and select the image file to open.

15.

To print an image once it’s saved or re-opened,
click on the printer icon in the main window or go
to the File menu and select Print.
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PURPOSE:

To isolate mitochondrial DNA from the hair using an enzymatic digestion of the
hair followed by an organic extraction.

PROCEDURE:

Only one hair should be processed at a time.
Processing the hair sample
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Before the hair can be processed, the packaging must be documented, and a photomicrograph of
the section of hair that will be tested should be captured. Following this, the hair will be cut,
washed, and digested before the organic extraction. Since little or no genomic DNA is expected
following such an extraction, a 20 :l aliquot from a total of 50Fl of the hair extract will be
submitted directly to Linear Array PCR amplification.

1.

Document the packaging of the hair on the mtDNA Hair Processing worksheet,
and open the packaging in a Labconco Dead-Air hood.

2.

Note the general features of the hair on the worksheet, including the length, color,
quality, whether or not the hair is mounted, whether the hair is curly, straight, etc.

3.

Identify a 2 cm region that will be cut for extraction. Carefully take the hair to the
Mideo stereo-microscope and capture a detailed photomicrograph (See the Mideo
section for details on instructions).
If the hair is mounted in a slide, photograph the hair on the slide and again
after it has been removed. For loose hairs, place the hairs on a kimwipe or in
a weighboat and photograph using direct light.

B.

Removing the hair from a mounted slide
If the hair is loose in the packaging, then skip ahead to Section C.
Process only one mounted slide at a time, the mountant softens quickly and hairs
will scorch if left on the heat plate too long.
1.

Turn on the heat plate and adjust the heat dial between 4-5. Place the slide on a
heat plate until the mountant softens, and using forceps remove the cover slip.
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The hair will be attached to either the coverslip or the slide. Place this piece into
the xylene bath for 5 minutes or until the mountant completely dissolves.

3.

Using clean forceps, carefully remove the freed hair from the xylene bath, and
place in a 1.5 ml microcentrifuge tube filled with 1 ml of xylene, and place in the
shaker for 5 minutes at 1400 rpm at room temperature.

4.

Examine the hair under the microscope to confirm that the mountant was
removed. If not, repeat the xylene wash in the microcentrifuge tube.

5.

Using the Mideo stereo-microscope, capture a detailed photomicrograph of this
loose hair. (See the Mideo section for details on instructions.)

di
na
to

r

2.

Ar
D ch
oc iv
um ed
en 07
t C /24
on /2
tro 01
lC 0
oo
r

C.

MITOCHONDRIAL DNA HAIR EXTRACTION

Cutting and Washing the hair

Do not cut the root of the hair for mtDNA testing. If present, remove the root by
cutting 1-2 cm up from the root and retain this segment on a labeled post-it backing
and place in a secure envelope.
1.

Place a clean weigh boat on top of a ruler with a metric scale. The scale will be
visible through the plastic bottom of the weigh boat. Place the hair into the weigh
boat and using forceps and a scalpel, cut a 2 cm section of the hair, preferably a
untreated/undyed section of the hair. Return the unused portion of the hair to
the packaging.

2.

Using clean forceps, place the 2 cm section of hair into a 1.5 ml tube with 1 ml of
5% Tergazyme detergent. Vortex the tube for 1 minute at high speed, and place
into the sonicator for 15 minutes. After sonication, vortex the sample again for 1
minute at high speed.

3.

Prepare a 50 ml Falcon tube and filter cup set by labeling the tube and filter cup
tab with the sample name. Pre-wet the filter cup membrane with 1 ml of dH2O.

4.

Remove the hair from the Tergazyme with clean forceps, and place the hair into
the filter cup in the center of the membrane.

5.

Wash the hair with 1 ml of dH2O. Allow the liquid to pass through the filter.
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Wash the hair with 1 ml of 0.85% saline. Allow the liquid to pass through the
filter.

7.

Wash the hair with 1 ml of 100% ethanol. Allow the liquid to pass through the
filter.

8.

Remove the filter cup containing the hair and place on a Kimwipe to let the
ethanol evaporate. Once the filter membrane is dry, the hair will be dry as well.

Enzymatic digestion of the hair
1.

r

6.
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MITOCHONDRIAL DNA HAIR EXTRACTION

Prepare the incubation solution using the following table:

1 hair + extraction negative
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Incubation Solution

Proteinase K (20mg/ml)

30 :l

DTT (1M)

75 :l

20% SDS

7.5 :l

Organic Extraction Buffer

188 :l

2.

Aliquot 150 :l of the incubation solution into a labeled 1.5ml microcentrifuge
tube.

3.

Using clean forceps, submerge the cleaned hair in the incubation solution.

4.

Incubate the hair for 30 minutes in a 1400 rpm shaker at 56EC.

5.

After 30 minutes, the hair should be dissolved. If it is not, spike the tube with 1:l
of 1M DTT and incubate overnight.

6.

When the hair is completely dissolved*, proceed immediately to the organic
extraction.

NOTE:

The hair might not completely digest even after a second input of DTT. If
the hair is chemically treated, straightened, or dyed, it might resist
digestion. The incubation process might remove the pigment or coloring
from a hair and leave it opaque. If this happens, make a note of this on
the extraction sheet and proceed to the organic extraction by removing
the supernatant from the tube, leaving the hair behind.
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Organic Extraction of the hair
Eppendorf Phase Lock Gel (PLG) tubes make the phase separation easier but are
optional. Prior to transferring incubated samples to 1.5 ml PLG tubes, these must be
centrifuged at maximum speed for 30 seconds. Refer to the “Protocols for Forensic STR
Analysis” manual for details on PLG preparation
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CAUTION: Phenol:Chloroform:Isoamyl Alcohol is an irritant that is toxic. Its use
should be confined to a hood. Nitrile or Vinyl gloves and a mask
should be worn.
Transfer the incubation buffer containing the dissolved hair to 1.5 ml PLG tubes
or microcentrifuge tubes, and add 150 :l (equal volume) of Phenol: Chloroform:
Isoamyl Alcohol (25:24:1 PCIA) to the tubes. This step must be done in the fume
hood.

2.

Shake or vortex the tube to achieve a milky emulsion.

3.

Centrifuge the tube in a microcentrifuge for 2 minutes at room temperature.

4.

Insert Microcon 100 columns (blue) into labeled microcon tubes for each sample.

5.

Prepare the Microcon 100 concentrator by adding 100 :l of TE-4 to the filter side
(top) of the concentrator.

6.

Transfer the aqueous phase (top layer) to the prepared Microcon 100 concentrator.
Do not disturb the PLG layer. Discard the PLG tube or microcentrifuge tube
containing the organic layer (if into the organic if the PLG tube is not used)into a
waste bottle in the fume hood.

7.

Spin the Microcon 100 concentrator for 25 minutes at 500 rcf.

8.

Add 400 :l of TE-4 to the filter side (top) of the concentrator.

9.

Spin again at 500 rcf for 25 minutes. Most of the liquid should pass through
the membrane, if not, the end volume of the sample might be greater than
50F
Fl.

10.

Add 20 :l of TE-4 to the filter side (top) of the concentrator.
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Invert the blue concentrator cup and place into a newly labeled tube. Spin at 1000
rcf for 3 minutes to collect the sample.

12.

Discard the blue concentrator cup and adjust the sample volume to 50 :l using
TE-4.

13.

Transfer the sample to a 1.5 ml microcentrifuge tube for storage. Store at 2 to
8EC or frozen.

Amplification of the hair extract

r

11.
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F.

MITOCHONDRIAL DNA HAIR EXTRACTION
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Submit 20 :l of the organic extract to PCR amplification.
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PURPOSE:

To increase the amount of available mtDNA for the purposes of analysis, by
performing an in vitro replication of template DNA using oligonucleotide
primers, thermostable DNA polymerase and deoxynucleoside triphosphate bases
(dNTPs) within a thermal cycler.

PROCEDURE:
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A positive control, an amplification negative, and an extraction negative control (if applicable)
should be included with each batch of samples being amplified to demonstrate procedural
integrity. The positive control is a laboratory grade cell line, and the full nDNA/mtDNA type is
known. Samples that were extracted together should all be amplified together, so that every
sample is run parallel to the extraction negative control.

A.
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Follow the Mito Pre-amp guidelines for handling the tubes and cleaning of the work surface.
The following steps have to be preformed in the appropriate dedicated areas. Evidence samples
and exemplar samples should not be handled at the same time.
Preparing the DNA aliquots for the amplification
1.

The target amounts to be amplified are 0.1 ng of DNA for the amplification
system. Follow Table I below for the amount of DNA to be added along with TE4
to achieve a total of 50 :l in the reaction tube. Table II refers to the preparation
of the control samples for the amplification.

2.

Remember the following rules:

If the neat and 1/10 QuantiBlot results are >10ng/20:l, dilute the sample 1/100
with TE-4 and re-quantitate. Multiply the diluted concentration by 100 to obtain
the original sample concentration. Repeat the procedure if the diluted sample is
still >10ng/20:l.
When a dilution is made to determine DNA concentration, it is preferable to
calculate the DNA concentration in the undiluted DNA extract. Then amplify the
undiluted DNA extract, not the dilution. When possible, always amplify the
optimal target amount of 0.1 ng.
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Table I – Amount of DNA to be amplified.
QuantiBlot DNA
Concentration
(ng/20ul)

Target Volume (:
:l)
to be amplified

Range of volumes
(:
:l) which can be
amplified

TE-4 for target
volume

>10

Re-quantitate

5

Dilute 1/10 and use the dilution for amplification

2.5

Dilute 1/10 and use the dilution for amplification
1.6

18.4

0.62

3.2

16.8

2.0 - 20**

0.5

4.0

16.0

2.8 - 20**

0.31

6.4

13.6

5.2 - 20**

8.0

12.0

6.8 - 20**

13.3

6.7

12.1 - 20**

0

N/A

0.15
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0.25

<0.15
20
-4
** Add TE to a final volume of 20 :l

1.0 - 20**

r

1.25

Table II – Control samples for amplification.

DNA

TE-4

20 :l

---

---

20 :l

If sample extracts are amplified neat

20 :l

---

If sample extracts require 1/10 dilution or greater

1 :l

19 :l

Sample

HL60 Positive Control DNA (0.1 ng/20 :l)
Amplification Negative Control
Extraction Negative Control
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Amplification Setup1
Always use fresh 0.5 ml amplification tubes directly from packaging. Ensure that
the 96 well rack is clean by exposing it to UV light in the stratalinker for a
minimum of 30 minutes.

2.

For each amplification set, fill out the worksheet (G:\Users\Fbiology\mtDNA\
Forms\Casework\laamp) and record the appropriate lot numbers.

3.

Determine the number of samples to be amplified, including controls and label a
0.5 ml PCR reaction tube for each sample.

4.

Prepare a master mix tube of the Reaction Mix and Primer Mix, using the
following calculation: For <10 samples, use N+1, for >10 samples, use N+2
 Reaction Mix:
_________ samples x 20 :l Reaction Mix = _________ :l
 Primer Mix:
_________ samples x 10 :l Primer Mix = _________ :l

5.

Vortex the Master Mix and bring to the bottom of the tube. Aliquot 30 :l of the
Master Mix into the bottom of each labeled 0.5 ml reaction tube.

6.

Close all of the tubes. At this stage have another analyst witness the tube setup.

7.

NOTE: Use a sterile filter pipette tip for each sample addition. Open only
one tube at a time for sample addition. The final aqueous volume in the PCR
reaction mix tube will be 50 :l. Transfer the 0.1 ng of target DNA to each
respective sample tube in accordance with Table I. After the addition of the
DNA, cap each sample before proceeding to the next tube. Do not vortex or
mix.

8.

When finished, cover the rack and place the samples in the amplification room
airlock.

di
na
to

r

1.

Ar
D ch
oc iv
um ed
en 07
t C /24
on /2
tro 01
lC 0
oo
r

B.

DUPLEX MITOCHONDRIAL DNA PCR AMPLIFICATION

1

The Reaction and Primer Mixes used here are from the Roche Linear Array Mitochondrial DNA HVI/HVII
Region-Sequence Typing Kit. See Appendix A and B for primer sequences HVIF, HVIR, HVIIF, HVIIR, used in
this kit and their mtDNA sequence locations, respectively.
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Thermal Cycling
Turn on the Perkin Elmer 9700 Thermal Cycler. (See manufacturer’s instructions).
Use the following settings to amplify the samples
9700 Thermal Cycler
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File: lamtdna

di
na
to

r

User: mtDNA

The amplification file is as followsSoak at 94EC for 14 minutes
- Denature 92EC for 15 seconds
34 cycles:
- Anneal at 59EC for 30 seconds
- Extend at 72EC for 30 seconds
Incubation at 72EC for 10 minutes
Storage soak at 4EC indefinitely

1.

Place the tubes in the tray in the heat block, slide the heated lid over the tubes,
and fasten the lid by pulling the handle forward.

2.

Start the run by performing the following steps:
a.

The main menu options are RUN CREATE EDIT UTIL USER. To
select an option, press the F key directly under that menu option.

b.

Verify that the user is set to “mtDNA” if not, select the USER option (F5)
to display the “Select User Name” screen.

c.

Use the circular arrow pad to highlight “mtDNA.” Select the ACCEPT
option (F1).

d.

Press the RUN button (F1) and select the “lamtdna” file.

e.

Verify that the reaction volume is set to 50 :l and the ramp speed is set to
9600 (very important).

f.

If all is correct, select the START option (F1).

The run will start when the heated cover reaches 103EC. The screen will then
display a flow chart of the run conditions. A flashing line indicates the step being
performed, hold time is counted down. Cycle number is indicated at the top of
the screen, counting up.
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Upon completion of the amplification, remove samples and press the STOP
button repeatedly until the “End of Run” screen is displayed. Select the EXIT
option (F5). Wipe any condensation from the heat block with a Kimwipe and pull
the lid closed to prevent dust from collecting on the head block. Turn the
instrument off.

r

IMPORTANT:
For all amplifications, return the microtube rack used to set up the samples for
PCR to the Pre-Amp room through the Pass-Through airlock.
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Turn instruments off ONLY when the Main Menu is displayed, otherwise there
will be a Power Failure message the next time the instrument is turned on. It will
prompt you to review the run history. Unless you have reason to believe that
there was indeed a power failure, this is not necessary. Instead, press the STOP
button repeatedly until the Main Menu appears.
In case of a real power failure the 9700 thermal cycler will automatically resume
the run if the power outage did not last more than 18 hours. The Uninterruptible
Power Supply present in the amplification room will power the thermalcyclers for
2-3 hours in the case of a total power outage. The history file contains the
information at which stage of the cycling process the instrument stopped. Consult
with the QA team and/or the Technical Leader on how to proceed.
After the amplification process, the samples are ready to be used for analysis.
They may be stored in the appropriate refrigerator at 2-8EC for a period of up to 6
months.
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PURPOSE:

To quantitate the amount of amplified mtDNA by direct comparison to a
molecular weight ladder containing known amounts of DNA following DNA size
separation by agarose gel electrophoresis.

PROCEDURE:

r

Following amplification, a 1.5% agarose gel is run to determine if the amplification was
successful (see Interpretation of Results section). The number of samples amplified will
determine the size of the gel needed. Fill out a “mtDNA product gel worksheet.”

A.
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Thirteen samples and three concentrations of ladders can be run on a 16-well gel; on a 20-well
gel, 17 samples and 3 ladders can be run. A ten-well gel (7 samples and three ladders) is also
available for small batch amounts.
Preparing the Gel
1.

In an Erlenmeyer flask, mix the following reagents:
Reagents

DNA Typing Grade
Agarose
1X TBE (or TAE)

Small Gel
(10-well)

Medium Gel
(14-well)

Large Gel
(16- or 20-well)

0.75 g

1.5 g

3.0 g

100 ml

200 ml

50 ml

2.

Heat the agarose solution to boiling in a microwave for 2-3 minutes, or on a hot
plate with a stir bar, until the agarose is completely dissolved. Bring the volume
back up to the original volume with 1X TBE. Allow the solution to cool.

3.

Assemble the gel apparatus and pour the liquid agarose into the tray. The gel
should be 1/4” thick or less. Position the comb and let gel solidify. For the best
results, always use the narrowest-gauge comb that is available.

4.

Once the gel is set, remove the comb and pour enough 1X TBE buffer into the
apparatus just to cover the gel.
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Preparing the samples
With the exception of the positive control, mix 4 :l of each amplified sample with
1 :l of the Orange Dye Lane Marker.

2.

Add the appropriate amount of the amplified HL60 positive control sample
according to the current QC specification and quantity sufficient to 4 :l with
dH2O.

3.

Prepare three molecular weight ladder (Roche XIV) dilutions by adding the
following:

r

1.

4.

C.

Mix 2 :l of ladder, 2 :l of dH2O, and 1 :l Orange Loading Dye
Mix 3 :l of ladder, 1 :l of dH2O, and 1 :l Orange Loading Dye
Mix 4 :l of ladder, and 1 :l Orange Loading Dye
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a.
b.
c.
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B.

MITOCHONDRIAL DNA PRODUCT GEL ANALYSIS

Vortex and spin all samples. Have another analyst witness the tube setup.

Loading and Running the gel
1.

The gel should be loaded with the three ladder samples in the middle of the
amplified samples, and from left to right (well #1 is on the far left, and so on).

2.

Load the full 5 :l into each well, making sure that the bottom of the wells are not
punctured, and that all of the samples and ladder fill into their respective wells.

3.

Run the small gel chamber at 100 volts for about 1 hour or the large gel at 150
volts for 1 hour (or until the Dye Lane Marker has run approximately 10 cm).
DNA is negatively charged and migrates to the positive electrode (anode). Make
sure that the gel is loaded and the electrodes and plugged in such that the DNA
migrates toward the positive electrode.

4.

Switch off the power supply and remove the gel from the tank.
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5.

Place the gel in the ethidium bromide bath (0.5 :g/ml) for 30 minutes.
CAUTION- ethidium bromide (EtBr) is extremely toxic! Always wear gloves
and discard all EtBr waste in accordance to departmental policy. Remove, rinse
with deionized water and place on the Bio-Doc-It curved side tray.

Bio-Doc-It Photography
1.

Place the Bio-Doc-It curved-side tray in the Bio-Doc-It chamber and close the
door. Turn on the Power and UV switches. The UV selector must be at 302nm!

2.

Adjust the zoom lens (the middle lens) until the entire screen is filled with the gel
image. Then, adjust the aperture (the top lens, closest to the camera) to achieve
good contrast. Finally, adjust the focus lens (the bottom lens) to properly resolve
the gel bands. (Small adjustments might be necessary to the zoom after focusing.)
Typically, the optimal settings for UV Gel photography with the Bio-Doc-It are:
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D.

MITOCHONDRIAL DNA PRODUCT GEL ANALYSIS

Aperture: 1-2

Zoom: 15

Focus: <1

3.

To further increase the contrast or achieve better resolution, the [+] and [-] buttons
on the Bio-Doc-It can be used to digitally enhance the image. Press [LIVE] to
return to a live (non-enhanced) image.

4.

Once the desired image is obtained in the LCD screen, it needs to be captured as a
digital image. Insert a floppy disk into the drive on the BioDoc-It. Once the
image is in focus and properly contrasted, press “Capture” on the control panel
and then press save. The image will save as a JPEG file on the disk, and this will
take about 30-40 seconds. Once done, remove the disk, open the file on any
computer and print out.

5.

When finished, turn off the UV switch and the Bio-Doc-It power. Remove the gel
from the chamber, and label the printed photograph with your initials and date.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.
All printed versions are non-controlled copies.

PROTOCOLS FOR FORENSIC MITOCHONDRIAL DNA ANALYSIS
7.

E.

MITOCHONDRIAL DNA PRODUCT GEL ANALYSIS

DATE EFFECTIVE

VERSION

PAGE

04-08-2005

2.0

4 OF 9

Polaroid MP4 Photography
CAUTION- exposure to UV light can be harmful to the skin and eyes. A UVblocking face shield or UV-blocking glasses are recommended.
To begin, place the Fotodyne UV illuminator on the MP4 stage, add the UVP
focusing template (the flourescent plastic square with the clock, calibrators, and
gradients) to the UV bed. Cover with the black-handled Fotodyne UV blocker.
Turn on the UV illuminator. Focus the MP4 camera on the focusing template.
Once achieved, switch off the UV light and remove the template.

2.

Using the Bio-Doc-It curved side tray, place the tray onto the UV bed and cover
with the black-handled UV blocker. Turn on the UV illuminator.

3.

Using the viewfinder, adjust the height and focus of the MP4 camera so all of the
gel is visible and clearly focused. Once focused, move the orange filter over the
lens to take the photograph.

4.

Photograph the gel at the widest (most open) aperture for 0.5-1 seconds
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1.

Aperture:
Shutter speed:
Film type:

4.5
Set dial to either 2 (½ second) or 1 (1 second)
Polaroid 667

5.

Remove the film and let develop for 60 seconds. If the photograph is out of
focus, not exposed properly, or does not accurately record the sample or ladder
bands, vary the exposure conditions and re-photograph.

6.

When finished, turn off the UV bench and label the photograph with your initials
and date.
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INTERPRETATION OF RESULTS:
A.

DNA molecular weight marker*

XIV Ladder

bp’s
2642

2 ul
234 ng

3 ul
4 ul
351 ng 468 ng
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1000

500
400
300
200
100

*

B.

53 ng
20 ng
15 ng
10 ng

79 ng
29 ng
22 ng
14 ng

105 ng
39 ng
29 ng
19 ng

Table is a graphic representation of the XIV molecular weight ladder with
corresponding basepairs (bp) and concentrations of DNA based on either the 2
:l, 3 :l, or 4 :l input

Quality of the amplified DNA product
The 444 bp HVI- and 415 bp HVII-specific bands should be between the 400 and 500 bp
bands of the DNA molecular weight ladder.
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Quantitation of the amplified DNA product

Proceed with sequencing.
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Use only the 500, 400, 300 and 200bp ladder bands for the quantitation. The intensity of
the fluorescence of the bands in the 2 :l, 3 :l, and 4 :l ladder samples will relate to the
concentration of the DNA in the samples using the guidelines in section A above. Match
each sample to the closest ladder band and fill in the values on the mtDNA Product Gel
Worksheet. Do not round the values. Do not assign values in between two bands. If the
band intensity is between two DNA standards, match the sample to the DNA standard
with the lower amount of DNA.
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AMPLIFICATION AND PRODUCT GEL TROUBLESHOOTING:

PROBLEM: Faint or no amplified product visible on gel for DNA samples or positive
controls. Fragments corresponding to the DNA Molecular Weight Marker
XIV ladder visible.
Possible Cause
(Amplification Problem)
No DNA added or insufficient DNA added
to Master Mix.

Recommended Action

Ensure positive control was diluted properly
and the correct concentration and volume was
added to reaction: quantitate DNA and add 100
pg DNA; repeat amplification.
Insufficient or no mtDNA HVI/HVII Primer Repeat amplification ensuring 10 :l of mtDNA
Mix or no mtDNA Reaction Mix added to
HVI/HVII Primer Mix and 20 :l of mtDNA
make Master Mix.
Reaction Mix is added to each reaction.
PCR instrument failure, wrong program or
Notify Quality Assurance Unit. See PCR
emulation mode not selected.
instrument system manual and check instrument
calibration; repeat amplification and ensure
emulation mode is selected.
Mistake during the amplification set up such Prepare new samples and repeat amplification.
as not adding one of the components or not
starting the thermal cycler.
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PROBLEM: Faint or no amplified product visible on gel for DNA samples or positive
controls. Fragments corresponding to the DNA Molecular Weight Marker
XIV also faint or missing.
Recommended Action

Ethidium Bromide concentration is too low in
bath.

Add more Ethidium Bromide to bath, re-soak
gel.
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Possible Cause
(Electrophoresis problem)

PROBLEM: Misshaped bands for DNA samples, positive controls or Molecular weight
Marker.
Possible Cause
(Electrophoresis problem)

Agarose not dissolved, wells not formed
properly.

Recommended Action

Prepare new gel and rerun samples.

PROBLEM: Signals in both or multiple negative controls with sizes corresponding to
HVI and/or HVII products visible on gel.
Possible Cause
Contamination.

Recommended Action
Refer to Interpretation Guidelines.
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PROBLEM: Positive control fails but sample signal level is fine.
Possible Cause

Recommended Action
Prepare new samples and repeat amplification
step.

Positive control lot degraded.

Notify Quality Assurance Unit to investigate
lot number, prepare new samples and repeat
amplification step.
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Mistake during the amplification set up such
as not adding enough of the positive control
DNA.

PROBLEM: Presence of unexpected or additional signals in the positive control.
Possible Cause

Recommended Action

Contamination by other samples;
contaminated reagents.

Notify Quality Assurance Unit to investigate
the amplification reagents, prepare new
samples and repeat amplification step.

Non-specific priming.

Notify Quality Assurance Unit to check
thermal cycler for correct annealing settings,
prepare new samples and repeat amplification
step.

PROBLEM: Strong signal from the positive controls, but no or below threshold signal
from DNA test sample.
Possible Cause
The amount of DNA was insufficient or the
DNA is severely degraded.

Recommended Action
Amplify a larger aliquot of the DNA extract.

Concentrate the extracted DNA using a
Re-extract the sample using a larger piece of
hair or more stain material to ensure sufficient Microcon 100 ultrafiltration device as
described in the Microcon section.
high molecular DNA is present.
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PROBLEM: Strong signal from the positive controls, but no or below threshold signal
from DNA test sample.
Possible Cause
Test sample contains PCR inhibitor (e.g.
heme compounds, certain dyes).

Recommended Action
Consult with a supervisor and select from the
following:
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1) Amplify a smaller aliquot of the DNA
extract to dilute potential Taq Gold
polymerase inhibitors.
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2) Re-extract the sample using a smaller
piece of hair or stain material to dilute
potential Taq Gold polymerase inhibitors.

3) Re-extract the samples using the organic
extraction procedure. Purify the
extracted DNA using a Microcon 100
ultrafiltration device as described in the
Microcon section.
4) Amplify using an additional 10 units of
Taq Gold Polymerase.
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PURPOSE:

Prior to cycle sequencing, unincorporated primers and nucleotides present in the
amplification reaction are deactivated by the addition of ExoSAP-IT.

PROCEDURE:
1.

Fill out the cycle sequencing spreadsheet for each sample that will be cycle sequenced.
(Microsoft Excel format. Filename: “CYCSEQ.XLS”. To be found on the Forensic
Biology network directory.)
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Fill in the proper columns with the number of product gels and any miscellaneous volume
used from each sample, as well as the original concentration as determined by the product
gel.

2.
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For a detailed description of the calculations performed in this spreadsheet, refer to
Appendix D – Detailed CycSeq Spreadsheet Calculations.
Based on the spreadsheet calculations, the ExoSAP-IT column will display the volume of
ExoSAP-IT that is to be added to that sample.
Fl of sample in the
There should be 1F
Fl of ExoSAP-IT added for every 5F
amplification tube
3.

Use the following settings to incubate the samples
9700 Thermal Cycler
User: mtDNA

The ExoSAP-IT file is as follows:
- Soak at 37EC for 15 minutes
- Soak at 80EC for 15 minutes

File: exosap-it

Storage soak at 4EC indefinitely
4.

Place the tubes in the tray in the heat block, slide the heated lid over the tubes, and fasten
the lid by pulling the handle forward.
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Start the run by performing the following steps:
a.

The main menu options are RUN CREATE EDIT UTIL USER. To select an
option, press the F key directly under that menu option.

b.

Verify that the user is set to “mtDNA.” If not, select the USER option (F5) to
display the “Select User Name” screen.

c.

Use the circular arrow pad to highlight “mtDNA.” Select the ACCEPT option
(F1).

d.

Select the “exosap-it” file, and press the RUN button (F1).

e.

Verify that the reaction volume is set to 50 :l and the ramp speed is set to 9600
(very important).

f.

If all is correct, select the START option (F1).
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5.

ExoSAP-IT SAMPLE CLEANUP

The run will start when the heated cover reaches 37EC. The screen will then display a
flow chart of the run conditions. A flashing line indicates the step being performed; the
hold time is counted down. Cycle number is indicated at the top of the screen, counting
up.
Upon completion of the amplification, remove samples and press the STOP button
repeatedly until the “End of Run” screen is displayed. Select the EXIT option (F5).
Wipe any condensation from the heat block with a Kimwipe and pull the lid closed to
prevent dust from collecting on the head block. Turn the instrument off.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.
All printed versions are non-controlled copies.

PROTOCOLS FOR FORENSIC MITOCHONDRIAL DNA ANALYSIS
9.

CYCLE SEQUENCING

DATE EFFECTIVE

VERSION

PAGE

04-08-2005

2.0

1 OF 2

PURPOSE:

Following the duplex mtDNA amplification, the samples identified as probative
will be sequenced to determine the mtDNA profile. The Sanger method is used to
cycle sequence the mtDNA in question using fluorescent dideoxynucleoside
triphosphate bases, incorporated into the Big Dye Terminator v3.1 Cycle
Sequencing Kit.

PROCEDURE:
Begin by filling out the Cycle Sequencing worksheet. (Microsoft Excel format.
Filename: “CYCSEQ.XLS”. To be found on the Forensic Biology network directory.)

di
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r

1.

Fill in the tube label, sample description, IA, and primer set for each sample.
Based on each sample’s previous runs, fill in the number of product gels, and any
miscellaneous volume used into the respective columns, as well as the concentration of
the amplified sample as determined by product gel analysis.
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2.

For a detailed description of the calculations performed in this spreadsheet, refer to
Appendix D – Detailed CycSeq Spreadsheet Calculations.
3.

The amount of template DNA and water needed for each sample is then calculated and
filled in on last two columns for each sample. This calculation takes into account the
total volume of amplified product left in the sample tube along with the concentration,
and first calculates the amount of ExoSAP-IT necessary for each sample (see the
ExoSAP-IT section). The concentration of the DNA is then adjusted based on the new
volume of the sample plus the ExoSAP-IT, and the volume of template DNA that is to be
added to each sample is calculated. The target amount for cycle sequencing is 5 ng of
amplified product.

4.

If the cycle sequencing reaction is to be performed in a 96-well plate, at this time
you must fill out the 3100 run sheet. Refer to the ABI 3100 Sequencing Setup,
Section E, Creating a Plate ID, for details. This 3100 run sheet will detail the
positions of the samples on the 96-well plate, and must be witnessed along with the
CycSeq worksheet.

5.

The following formula is then used to create each sample for cycle sequencing
4 :l of Big Dye Terminator Ready Reaction Mix + 2 :l of Sequencing Buffer + 3.2 :l
Primer (1 :M concentration) + mtDNA template + Water = 20 :l total volume
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If a dilution of template DNA is necessary, it will be indicated on the cycle sequencing
worksheet in the comment column as “ x @ 1/10" where x is the input volume. If no
dilution is necessary, the comment column will contain the notation “neat.” The amount
of water that will be quantity sufficient to 20Fl is then calculated. If a sample is a
negative control sample, the gel concentration of zero will result in a default template
input of 3Fl, with the notation of “control” in the comment column.
A master mix for each primer can be made with the following formula:
For (N+1) samples, add:
• 4 :l x (N+1) Big Dye Terminator Ready Reaction Mix
• 2 :l x (N+1) Sequencing Buffer
• 3.2 :l x (N+1) primer (1uM concentration)

b.

Aliquot 9.2 :l of master mix to each amp tube for that primer, add the mtDNA
and water based on the CycSeq worksheet.

c.

Include all controls for each primer that is used for a sample. If a sample is
repeated starting at the cycle sequencing step the original negative controls
do not have to be repeated if the first test was successful.

d.

The re-cycle sequencing step requires the following:
• A new cycle sequencing amplification negative control for each primer
used in re-cycle sequencing to account for the cycle sequencing reagent.
• A positive control, for each primer used in re-cycle sequencing to report
on the integrity of the reaction.

6.
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a.

Use the following settings to amplify the cycle sequencing samples:
9700 Thermal Cycler
User: mtDNA
File: BDT cycle seq

The cycle sequencing amplification file is as follows:
Soak at 96EC for 1 minute
- Denature 96EC for 15 seconds
25 cycles:
- Anneal at 50EC for 1 seconds
- Extend at 60EC for 1 minutes
Storage soak at 4EC indefinitely
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PURPOSE:

To help separate the primers from the cycle-sequenced DNA with the addition of
2% SDS to the samples, prior to Centri-Sep filtration.

PROCEDURE:

r

Do not refrigerate the 2% SDS tubes. This will cause the SDS to precipitate out of solution.
Store the 2% SDS tubes at room temperature. Ensure that there is no precipitate in the
tube before adding to samples.
Add 2Fl of 2% SDS to each tube of cycle-sequenced DNA. Spin down the tubes in a
centrifuge.

2.

Place the tubes in a thermalcycler, using the following conditions-
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1.

9700 Thermal Cycler
User: mtDNA

The 2% SDS incubation file is as follows:
Soak at 98EC for 5 minutes
Storage soak at 25EC for 10 minutes

File: SDS
3.

When the tubes are back to room temperature following the 25EC soak, proceed to the
Centri-Sep purification.
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PURPOSE:

Prior to sample electrophoresis, sequenced products must be purified in order to
remove unincorporated dye terminators.

Procedure for Single Columns
Gently tap columns to insure dry gel material has settled to bottom of spin
column. Remove top column cap and add 800 :L of sterile dH2O to one column
for each sequencing reaction.

2.

Replace top cap and mix thoroughly by inverting column and vortexing briefly. It
is important to hydrate all of the dry gel. Allow columns to hydrate for at least 2
hours at room temperature. As the columns are hydrating you will need to label
one sample collection tube (1.5 mL microcentrifuge tube) for each sequencing
reaction. You will also need one wash tube for each hydrated column. These do
not need to be labeled.

3.

Once the columns are hydrated, remove any air bubbles by inverting the column
and sharply tapping the column, allowing the gel to slurry to the opposite end of
the column. Stand the column upright and allow the gel to settle while in a
centrifuge tube rack.

4.

Once the gel is settled, remove first the top column cap, and then remove the
column end stopper from the bottom. Allow excess column fluid to drain into a
wash tube by first gently tapping the column into the wash tube then allowing to
sit for approximately 5 minutes. Remove the column from the wash tube, discard
the liquid and reinsert the column into the wash tube.

5.

Spin the assembly at 700 x g for 2 minutes to remove interstitial fluid. Be sure to
note the orientation of the columns. At this point the columns should be used as
soon as possible for the loading of cycle sequenced DNA product.

6.

Load entire sequencing reaction volume (20 :L) to the top of the gel. Be careful
to dispense sample directly onto the center of the gel bed without disturbing the
gel surface.

7.

Place column into labeled sample collection tube and spin at 700 x g for 2
minutes maintaining original orientation. The purified sample will collect in the
bottom of the tube.

r

1.
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A.

CENTRI-SEP SAMPLE FILTRATION
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8.

Discard the column and dry the sample in a vacuum centrifuge (approximately
15-20 minutes). Do not over dry samples.

9.

If the samples are not going to be loaded immediately, they should be stored as a
dried pellet at 4°C for no longer then 14 days. When ready, proceed to 3100
setup.

r

Procedure for Centri-Sep 8 Strips
Determine how many strips are necessary to filter the amplified samples.
Separate the desired number of strips by cutting the foil between the strips with
scissors.

2.

Open the well outlets on each strip by cutting off the bottom edge with scissors.
Cut at the narrowest part of the bottom of the tube.

3.

Peel off the top foil and arrange the strips evenly on deep-well centrifuge plates.
Spin the plates at 750 x g for 2 minutes to remove the liquid.

4.

Arrange the newly drained strips on a new 96-well plate. Add the amplified
sample to each column.

5.

Once all of the samples are loaded, place the 96-well plate with the Centri-Sep 8
Strips into the centrifuge, and spin at 750 x g for 2 minutes.

6.

Confirm that all of the samples passed through the strip into the wells of the 96well plate, and discard the Centri-Sep 8 Strip.

7.

Evaporate the samples in the 96-well plate at 75EC in a thermalcycler with the lid
open.
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B.

CENTRI-SEP SAMPLE FILTRATION

Procedure for the Centri-Sep 96 plate
1.

Allow the Centri-Sep 96 plate to come to room temperature.

2.

Remove the adhesive foil from the bottom of the plate first. Then, remove the
foil from the top of the plate. Place on a deep-well centrifuge plate.
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Spin the Centri-Sep 96 plate at 1500 x g for 2 minutes to remove the excess
liquid.

4.

Place the Centri-Sep 96 plate on a new 96-well plate and load the samples into the
individual columns.

5.

Once all of the samples are loaded, place the Centri-Sep 96 plate/96-well plate
combination in the centrifuge and spin at 1500 x g for 2 minutes.

6.

Confirm that all of the samples passed through the strip into the wells of the 96well plate, and discard the Centri-Sep 96 plate.

7.

Evaporate the samples in the 96-well plate at 75EC in a thermalcycler with the lid
open.
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3.
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PURPOSE:

The 3100 16-capillary array system is used to electrophoretically analyze samples
following cycle sequencing and Centri-Sep cleanup. The system uses 96-well
plates containing the samples of interest, and processes 16 separate samples with
each injection. Sequence data is generated at the end of the run for downstream
sequencing analysis.

OVERVIEW
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Turn on the computer. Make sure computer is fully booted to the Windows desktop. If the
instrument is not on, turn it on. The status bar light will change from solid yellow (indicates
instrument is booting) to blinking yellow (indicates machine is communicating with computer)
and then to solid green (indicates instrument is ready for command).
NOTE: Collection cannot be launched unless the light on the instrument is green!
Important phrase to remember, “If the light isn’t green, the machine becomes mean!”
The program that is used to operate the run and collect the data is the ABI Prism 3100 Collection
Software. To begin collection, double click on the Run 3100 Data Collection v2.0 icon. A
window will open and four icons will turn from red circles to yellow triangles to green boxes,
indicating that the system is operating properly. The final window to open will be the
Foundation Data Collection window. If the Foundation Data Collection window is closed, this
will appear as a red circle in the 3100 Data Collection window. Right-click on this red circle and
select “Start” from the pop-up menu. Foundation Data Collection will begin again.
To decide at which point of the manual to proceed:
1.

If the number of injections you are running plus the capillary usage number will exceed
150 injections, proceed with Section A “Changing and Installing the Capillary”.

2.

If the amount of POP6 in the installed syringe is low (<600 :L/tray) or greater than one
week old, you will have to change it. Start with Section C “Changing/Filling Syringes
with POP6".

3.

If the capillary and POP6 are fine at the first run of the day, start with Section D
“Changing the Buffer” to change the buffer and water.

4.

If the instrument has been run prior today and buffer and water had been changed then
proceed to Section E “Creating a Plate ID”.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.
All printed versions are non-controlled copies.

PROTOCOLS FOR FORENSIC MITOCHONDRIAL DNA ANALYSIS
12.

A.

ABI 3100 SEQUENCING

DATE EFFECTIVE

VERSION

PAGE

04-08-2005

2.0

2 OF 23

Changing and Installing the Capillary

r

The 3100 capillary array is a replaceable unit composed of 16 silica capillaries. The
capillary usage number refers to the number of times the array has injected a set of 16
samples. Check the capillary array usage number by clicking on the instrument (either
HVI or HVII) in the tree view in the left window. The number of current injections is on
the main page of the collection window, under “Array usage.” If this number, plus the
number of your injection sets (6 for a 96 well plate) exceeds 150, the capillary array
should be changed.
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To replace a capillary array or to install a capillary array on an instrument, close the oven
and instrument doors. From the Wizards menu, select Install Capillary Wizard.
Follow the directions given in the wizard to replace or install an array.
The steps involved in the Install Capillary Wizard are:
1.

From the Capillary Array Wizard window, select the Remove and Discard the
Array option. Click Next.

2.

Push the tray button. Wait for the tray to stop moving before opening the
instrument doors. The Capillary Array Wizard will then instruct you to “open
instrument door, oven door, and detection block door”.

3.

Unclip the leading-end head combs of the array from the oven by pulling on the
pins to the left and right of the comb.

4.

To loosen the screw holding the end of the capillary inside the upper polymer
block, unscrew towards you. Remove the syringe guard and pull the upper
polymer block out towards you, gently but with a bit of force, until you feel the
block reach a stop point. The capillary detection cell will pop out of position.
Remove the capillary from the oven slots holding it in place.

5.

Completely remove the screw and ferrule holding the end of the capillary inside
the upper polymer pump block. Remove the capillary assembly and discard it.
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Completely unscrew and remove syringes and tubing from upper and lower
polymer blocks. Remove upper and lower polymer blocks from instrument.
Clean the upper polymer block with hot, NOT BOILING, water using the
cleaning syringe. Also clean the ferrule and screw. A final rinse of deionized
water should be done. Vacuum or air dry the block and put the block back in the
instrument without sliding either block all the way in. Click Next.

7.

Select Install a New Capillary Array from the options. Enter the Serial
Number of the capillary array located on the capillary array box. Also record the
serial number of the capillary and the date in the 3100 Capillary Electrophoresis
Log binder. Keep the capillary box for future use. Click Next.

8.

Slide the capillary leading-end head comb holder into the oven and snap the
loading end of the array in place. To secure the capillary comb in place, push
both buttons until they snap into place.

9.

Place the capillary placement slots into their respective positions in the oven.

10.

Remove the detection window protection clip from the capillary window. Make
sure the window is clean (no dust or smudges). Slide the capillary assembly into
the upper polymer block with the screw and ferrule and place the capillary
detection cell in place. Push the polymer block back into place. Tightly screw
the array assembly into the polymer block. Click Next.

11.

Close the laser detection door and screw it shut. Close the oven door.

12.

Fill the clean syringes with polymer and install them on the polymer block.
Return the syringe guard. Click Next.

13.

Push the pistons on both syringes slowly to remove any air bubbles. Continue to
push the piston of the large syringe to fill both the upper and lower block with
polymer.
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6.

IMPORTANT: Pay close attention to any air bubbles trapped next to the end
of the capillary assembly and remove them. Also, make sure that all air
bubbles are removed from the assembly tubing connecting the upper and
lower polymer block. This is a non-transparent tube and bubbles are not
visible through it. Any bubbles left in it can cause electrophoresis problems.
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Close the instrument doors and wait for the autosampler to stop moving. Click
No if there are no air bubbles remaining. Click Next.

15.

Click Fill to fill the new capillary array. This will take a few minutes. Wait for
the Finish button to become active, then click it.

16.

Push the Tray button to present the tray. Once the autosampler has stopped
moving, open the doors and change the buffer in the anode jar and the water and
buffer in the reservoirs in the autosampler. Close the doors and Click Finish.
The software will not accept the new information unless the Finish button is
clicked.

17.

Once the capillary array wizard is finished, a spatial calibration must be done as
described in the following section.

Ar
D ch
oc iv
um ed
en 07
t C /24
on /2
tro 01
lC 0
oo
r

di
na
to

r

14.

ATTENTION: Since pump block was removed and the capillary window
was disturbed, you need to perform a spatial calibration (see B.) before
running samples.
18.

B.

Monitor the EP Current closely during the first injection. Make sure the EP
Current is not fluctuating too much (ex. going from 20 to 160 then down again,
etc.) Fluctuation of the EP Current is a good indicator that bubbles may be present
and if the run is stopped immediately, the lower block can be saved. If, after 20
minute of the first run, the EP Current is constantly around 70 or 80 FA, it’s good.

Performing a Spatial Calibration

A spatial calibration provides information about the position of the fluorescence from
each capillary on the CCD. It must be performed after each time a capillary array is
replaced or temporarily moved from the detection block.
1.

Click on the Spacial Run Scheduler in the left window. If the capillary was just
filled due to changing the POP6 or capillary, select “3100SpacialNoFill_1” from
the drop-down list. If you have not filled the capillary recently, select
“3100SpacialFill_1”.

2.

Click Start. The calibration will take 2 or 6 minutes, depending on whether, or
not, the capillaries are being filled.
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Upon completion, a dialog box will indicate if the spatial calibration was
successful. Successful results yield 16 sharp peaks with similar heights having
position (pixel) values of 13-16 units (15 is optimal) higher for each subsequent
capillary. A good spatial should be no less than 8000 units high.

4.

If the peaks do not fit these specifications, click Reject, and press Start again to
perform another test. Follow step 3. If the spatial still does not fit the
requirements, re-run the spacial with the “3100SpacailFill_1" option.

5.

If the peaks fit the specifications in step 3, click Accept.

6.

If the spatial calibration is continuously unsuccessful, see the 3100
troubleshooting section.

7.

Proceed with section E
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C.

ABI 3100 SEQUENCING

Changing/Filling Syringes with POP6

Check the amount of POP6 that remains in the reservoir syringe (the large 5.0 mL syringe
on the left). For a full tray (i.e. 96 samples or 6 injections), there should be at least 600
:L of POP6 in the reservoir syringe or the run will not start. The array fill syringe
(smaller 250 :L syringe on the right) will be filled automatically by the reservoir syringe
when it comes time to fill the capillary array. Never add fresh polymer to old polymer.
Check the 3100 Capillary Electrophoresis Log binder to see when the polymer was last
changed. The polymer should be changed once a week. Document the change of
polymer and its lot number in the 3100 Capillary Electrophoresis Log binder.
Completely unscrew and remove the large syringe from the upper polymer block. Clean
out the large syringe with deionized water. Do not overdraw the syringe plunger, as this
will damage the syringe. Once clean, gently tap dry. In the large syringe, draw 1/3-1/2
polymer into the syringe. Reattach the large syringe to the pump block by firmly
screwing it into place.
From the Wizards menu under Instrument Status, select Change Polymer Wizard.
Follow the directions given in the wizard to put fresh polymer on the instrument.
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The steps involved in the Change Polymer Wizard are:
From the Polymer Wizard window, click Close to close the anode buffer pin
valve and Home to home the syringes. Click Same Polymer Type, the
instrument uses only POP6 polymer at this time. Click Next.

2.

Fill the large syringe with new polymer (see above). Make sure the syringe is free
of any air bubbles and install it back onto the polymer block. Click Next.

3.

Click Open to open the anode buffer. Enter the polymer lot number, polymer
type, and expiration date. Click Next.

4.

Select whether this is a new lot of polymer or the same as before, and click Next.

5.

Push the pistons on both syringes slowly to remove any air bubbles. Use the
small syringe to remove any bubbles from the corner of the block near the
capillary. Continue to push the piston of the large syringe to fill both the upper
and lower block with polymer and remove the remaining air bubbles.
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1.

IMPORTANT: Pay close attention to any air bubbles trapped next to the
end of the capillary assembly and remove them. Also, make sure that all air
bubbles are removed from the assembly tubing connecting the upper and
lower polymer block. This is a non-transparent tube and bubbles are not
visible through it. Any bubbles left in it can cause electrophoresis problems.
6.

Click No when all of the air bubbles are gone. Click Next.

7.

Replace the buffer in the anode jar and Click Finish.

8.

The capillary and small syringe must be flushed of old POP6 with new POP6.
From Wizards in the main menu, select Fill Capillary Wizard. Select
50cm/POP6 in the capillary length/polymer dropdown list, and click Fill. This
will take a few minutes to complete. When finished, click Finished.

9.

Monitor the EP Current closely during the first injection. Make sure the EP
Current is not fluctuating too much (ex. going from 20 to 160 then down again,
etc.) Fluctuation of the EP Current is a good indicator that bubbles may be present
and if the run is stopped immediately, the lower block can be saved. If, after 20
minute of the first run, the EP Current is constantly around 70 or 80, it’s good.
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NOTE: You must change the polymer weekly. The polymer is good at 25oC
for about 7 days.

D.

Changing the Buffer

r

The cathode buffer and water reservoirs located on the autosampler tray and anode buffer
jar located below the lower pump block should be changed at the beginning of each day
the instrument is in use.
To fill the water and cathode buffer reservoirs on the autosampler, close the
instrument doors and press the tray button on the outside of the instrument to
bring the autosampler to the forward position. Wait until the autosampler has
stopped moving and then open the instrument doors.

2.

Remove all reservoirs and anode jar and dispose of the remaining fluid. Rinse
and fill the water reservoirs to the line with Ultra-Pure water and the cathode
reservoir and anode with 1X running buffer, about 16 mL each. Dry the outside
of the reservoirs using a Kimwipe and place a clean septa strip on each reservoir,
as needed (it is OK to reuse septa).
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1.

Place the reservoirs in the instrument in their respective positions, as shown
below.
3.

Close the instrument doors.

NOTE: When using the 3100, it is not necessary to fill the water reservoir in
position #3.
Position of reservoirs in autosampler:

Water Reservoir
(rinse)

Water Reservoir
(waste)

2

4

Cathode reservoir
(1X running buffer)
1

Empty
3
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NOTE: Be sure that the septa fit snugly and flush on the tops of the
reservoirs in order to prevent damage of the capillary tip. Also, it is
important that there is no condensation on the inside of the reservoir. The
septa strips must be dry!
Creating a Plate ID
Click on the Plate Manager line in the left window.

2.

Select “New” from the bottom of the screen. Fill in the info in the new window to
name the new plate. Make sure there are no spaces in the plate name. Add a Run
Description if necessary, the Run Description must only be one line. In the
Application drop-down list, select Seqencing Analysis. Make sure the plate type
is 96-well. Add the owner name (eg. NYC OCME) and operator name (analyst
initials). Click on “OK.”

3.

The Sequencing Analysis Plate Editor window will now open. Fill in the sample
name in the “sample name” column (with no spaces; also do not use any of the
following characters: \ / : * “ > < | ? ‘), and the tube label in the “comment”
column. The priority should be 100 for each sample. The Results Group,
Instrument Protocol and Analysis Protocol are populated as the following:

r
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E.

Dye Set System

Big Dye
Terminator v3.1

Results Group

mtDNA_Results

Instrument
Protocol

Analysis Protocol

Big_Dye_v3.1 3100POP6_BDTv3KB-DeNovo_v5.1

You only need to select the first sample in each column. Then click on the
column header, and under the Edit menu, select “Fill Down” or use the keyboard
shortcut Ctrl+D. The rest of the samples should populate with the same data.
4.

If samples are to be re-injected, select Add Sample Run from the Edit menu.
This will create a second set of Results Group, Instrument Protocol, and Analysis
Protocol columns. Fill these columns out the same way as before, and they will
allow the samples to be re-injected.

5.

Click OK to save the run sheet.
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6.

On the main Plate Manager screen select the plate ID you just created, and click
“export” on the bottom of the screen, and save the run sheet as a text file into the
Run Sheets file at
E:\Applied Biosystems\UDC\data collection\data\ga3100\Instrumentname\Run
Sheets
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Click Save.

r

Using the following format:
InstrumentnameYear-Run # (example- Spiderman04-007.txt)

On the desktop, open the Microsoft Excel file 3100run. Click on the “Import”
tab on the bottom of the pages. Click the box 1A.

8.

In the Data menu at the top of the screen, click Refresh Data. When the menu
opens, find the text file for the plate ID saved in:
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7.

E:\Applied Biosystems\UDC\data collection\data\ga3100\Instrumentname \Run
Sheets
Click Import.
9.

The fields on the Import page should populate with the run data from the 3100
Data Collection software. Click on the Run Sheet tab on the bottom of the page.

10.

Fill in the name of the 3100 run in the space to the right of the “Run Sheet
Name.” Fill in the analyst’s initials next to the respective samples.

11.

Save the sheet as an Excel Workbook into the Run Sheets file at:
E:\Applied Biosystems\UDC\data collection\data\ga3100\Instrumentname \Run
Sheets
Using the following format:
InstrumentnameYear-Run # (example- Spiderman04-007)
Click Save.

12.

Print a hard copy of the run sheet and close Excel.
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Preparing the DNA Samples for Sequencing
Arrange amplified samples in a 96-well rack according to how they will be loaded into
the 96- well reaction plate. Sample order is as follows: A1, B1, C1, D1... G1, H1, A2,
B2, C2... G2, H2, A3, B3, C3, etc. Thus the plate is loaded in a columnar manner where
the first injection corresponds to wells A1 to H2, the second injection corresponds to
wells A3 to H4 and so on. Label the side of the reaction plate with the name used for the
Plate ID with a sharpie.

r

Remove the Hi-Di formamide from the freezer and allow it to thaw. Add 10 :l of
formamide to each dried sample, and mix to bring the sample into solution.
Briefly spin down the samples to bring the liquid to the bottom of the tubes.
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1.
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Once formamide is thawed and aliquoted, discard of the tube. Do not refreeze opened tubes of Hi-Di formamide.
2.

If single Centri-Sep columns were used, load the entire 10 :l of the resuspended
samples into the 96-well tray in the appropriate wells. The injections are grouped
into 16 wells starting with A1, B1, and so on moving down two columns ending
with 2G, 2H, for a total of 16 wells. Fill any unused wells that are part of an
injection set (eg., containing <16 samples) with 10Fl of Hi-Di formamide.

3.

Once all of the samples have been added to the plate, place the 96-well Septa over
the reaction plate and firmly press the septa into place. Spin plate in centrifuge for
one minute.

4.

Remove the reaction plate from the base and heat denature samples at 95oC for 2
minutes followed by a quick chill at 4oC for 5 minutes, either using two ABI 9700
thermal cyclers that are set at the two temperatures, or two 96-well thermomixers
set at the two temperatures. Make sure to keep the thermal cycler lid off of the
sample tray to prevent the septa from heating up. After removing tray from the
heat block, check the wells for air bubbles. If there are any, centrifuge the tray to
remove any air bubbles.

5.

Once denatured, place the reaction plate into the plate base. Secure the plate base
and reaction plate with the plate retainer.
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IMPORTANT: Damage to the array tips will occur if the plate retainer and septa
strip holes do not align correctly.
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IMPORTANT: Do not write on the septa with pen, markers, sharpies, etc. Ink may
cause artifacts in samples. Any unnecessary markings or debris on the septa may
compromise instrument performance.
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Placing the Plate onto the Autosampler
The Autosampler holds up to two, 96-well plates in tray positions A and B. To place the
plate assembly on the autosampler, there is only one orientation for the plate, with the
notched end of the plate base away from you.
Push the tray button on the bottom left of the machine and wait for the
autosampler to move forward and stop at the forward position.

2.

Open the doors and place the tray onto the autosampler in the correct tray
position, A or B.

3.

Ensure the plate assembly fits flat in the autosampler. Failure to do so may allow
the capillary tips to lift the plate assembly off of the autosampler.
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1.

When the plate is correctly positioned, the plate position indicator on the Plate
View page (under Run Scheduler) changes from gray to yellow. Close the
instrument doors and allow the autosampler to move back to the home position.
NOTE: When removing a plate from the autosampler, be careful not to hit
the capillary array. Plate B is located directly under the array, so be
especially careful when removing this tray.

H.

Linking the Plate Record to a Plate
1.

On the Plate View screen (under Run Scheduler in the left window), click on the
plate ID that you are linking. If the plate ID is not available click Find All, and
select the plate ID created for the run. Then click the plate position (A or B) that
corresponds to the plate you are linking.

2.

Once the plate has been linked, the:
• Run Instrument button on the toolbar becomes highlighted, meaning that the
instrument is ready to run.
• Plate position indicator for the linked plate changes from yellow to green
NOTE: It may take a minute for the plate record to link to the plate
depending on the size of the sample sheet.
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If two plates are being run, the order in which they are run is based on the
order in which the plates were linked.
3.

Click the Run View (under Run Scheduler in the left window) to view the run
schedule. The RunID column indicates the folder number(s) associated with each
injection in your run. These folder number(s) should be recorded in the 3100 Log
binder along with the run control sheet name. Click Run to start the run. NOTE:
Before starting a run, check for air bubbles in the polymer blocks.
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To check the progress of a run, click on the Cap/Array Viewer or Capillaries
Viewer in the left window. The Cap/Array Viewer window will show the raw
data of all 16 capillaries at once. The Capillaries Viewer window will show you
the raw data of the capillaries you select to view.
IMPORTANT: Always exit from the Cap/Array Viewer and the Capillaries
Viewer windows. During a run, do not leave these pages open for extended
periods. This may cause unrecoverable screen update problems. Leave the
Instrument Status window open.
The visible settings should be:

EP voltage 10.7 kV
Laser Power Prerun 7.5 mW
Laser Current (no set value)

Expected values are:

EP current (no set value)
Laser Power During run 15 mW
Oven temperature 50°C

EP current constant around 40 to 60 :A starting current;
EP current constant around 70 to 80 :A running current
Laser current: 5-6 A

It is good practice to monitor the initial injections in order to detect problems.
I.

To Unlink a Plate
1.

In the Linked Plate Records table of the Plate View page, select the plate record
that you want to unlink.

2.

Click Unlink. The plate record will return to the Pending Plate Record table and
the plate position indicator will return to yellow.
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3100 Genetic Analyzer Troubleshooting
Instrument Startup
Observation

Possible Cause

Make sure the oven door is
closed and locked and the front
doors are closed properly. If
everything is closed properly,
start up in the following
sequence:
a. Log out of the computer.
b. Turn off the instrument.
c. Boot up the computer.
d. After the computer has
booted completely, turn the
instrument on. Wait for the
green status light to come on.
e. OrbixWeb Daemon should
be launched, if not already.
f. Launch Data Collection
software.
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No communication between Instrument not started up
the instrument and the
correctly.
computer (yellow light is
blinking).

Recommended Action

Red light is blinking.

Incorrect start up procedure.

Start up in the following
sequence:
a. Log out of the computer.
b. Turn off the instrument.
c. Boot up the computer.
d. After the computer has
booted completely, turn the
instrument on. Wait for the
green status light to come on.
e. OrbixWeb Daemon should
be launched, if not already.
f. Launch the Data Collection
Software.
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Possible Cause

Recommended Action

Computer screen is frozen.

Communication error. This
may be due to leaving the
user interface in the
Capillary View or Array
View window.

There will be no loss of data.
However, if the instrument is in
the middle of a run, wait for the
run to stop. Then, exit the Data
Collection software and restart as
described above.
Restart the system, and then
press the Tray button.

OR

OR

a. Close and lock the oven
door.
b. Close the instrument doors.
c. Press the Tray button.
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Oven or instrument door is
not closed.
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Autosampler does not move Possible communication
error,
to the forward position.

r

Observation

Communication within the
computer is slow.

Database is full.

Old files need to be cleaned out
of the database. Follow proper
manual procedures described in
the ABI Prism 3100 Genetic
Analyzer User’s Manual.
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Possible Cause

Recommended Action

Spatial Calibration

Check or repeat spatial
calibration.

Improper installation of the
detection window.

Reinstall the detection
window and make sure it fits
in the proper position.

r

The instrument may need
more time to reach stability.
An unstable instrument can
cause a flat line with no peaks
in the spatial view.

Ar
D ch
oc iv
um ed
en 07
t C /24
on /2
tro 01
lC 0
oo
r

Unusual peaks or a flat line
for the spatial calibration.
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Observation

Broken capillary resulting in a Check for a broken capillary,
bad polymer fill.
particularly in the detection
window area. If necessary,
replace the capillary array
using the Install Array
Wizard.

Persistently bad spatial
calibration results.

Dirty detection window.

Place a drop of METHANOL
onto the detection window,
and dry. Use only light air
force.

Bad capillary array.

Replace the capillary array,
and then repeat the
calibration. Call Technical
Support if the results do not
improve.
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Spectral Calibration
Recommended Action
Replace samples with fresh
samples prepared with fresh
formamide.

Air bubbles in sample tray.

Centrifuge samples to remove
air bubbles.
Refill the capillaries using
manual control. Look for
clogged capillaries during
capillary fill on the cathode
side.
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If the spectral calibration fails, Clogged capillary
or if a message displays “No
candidate spectral files
found”.

r

No signal.

Possible Cause
Incorrect preparation of
sample.
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Observation

Spike in the data.

Incorrect parameter files
and/or run modules selected.

Correct the files and rerun the
calibration.

Insufficient filling of array.

Check for broken capillaries
and refill the capillary array.

Expired matrix standards

Check the expiration date and
storage conditions of the
matrix standards. If
necessary, replace with a fresh
lot.

Expired polymer.

Replace the polymer with
fresh lot using the change
Polymer Wizard.

Air bubbles, especially in the
polymer block tubing.

Refill the capillaries using
manual control.

Possible contaminant or
crystal deposits in the
polymer.

Properly bring the polymer to
room temperature; do not heat
to thaw rapidly. Swirl to
dissolve any solids. Replace
the polymer if it has expired.
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Run Performance
Observation

Bubbles in the system.

Recommended Action
Visually inspect the polymer
block and the syringes for
bubbles. Remove any bubbles
using the Change Polymer
Wizard. If bubbles still persist,
perform the following:
a. Remove the capillary array
b. Clean out the polymer block
and syringes.
c. Replace polymer with fresh
polymer. Make sure to draw the
polymer into the syringe very
slowly.
Centrifuge the sample tray.

No signal.
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No data in all
capillaries

Possible Cause

Low signal strength.

Dead space at bottom of sample
tube.
Bent capillary array.

Replace the capillary array

Failed reaction.

Repeat reaction.

Cracked or broken capillary

Visually inspect the capillary
array including the detector
window area for signs of
breakage.

Poor quality formamide.

Use a fresh lot of formamide

Insufficient mixing.

Vortex the sample thoroughly,
and then centrifuge the tube to
condense the sample.

Weak amplification of DNA

Re-amplify the DNA.

Instrument/Laser problem

Run instrument diagnostics.
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Observation

Recommended Action
Wash the polymer block with
hot water. Pay particular
attention to the upper polymer
block, the ferrule, the ferrule
screw, and the peek tubing. Dry
the parts by vacuum pump
before replacing them onto the
instrument.
Bring the polymer to room
temperature, swirl to dissolve
any deposits. Replace polymer
if expired.
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Possible contaminant or crystal
deposits in the polymer.
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Elevated baseline

Possible Cause
Possible contamination in the
polymer path.

Loss of resolution.

Poor spectral calibration.

Perform new spectral
calibration.

Detection cell is dirty.

Place a drop of methanol onto
the detection cell window.
Dilute the sample and reinject.

Too much sample injected.
Poor quality water.

Use high quality, ultra pure
water.

Poor quality or dilute running
buffer.

Prepare fresh running buffer.

Poor quality or breakdown of
polymer.

Use a fresh lot of polymer.

Capillary array used for more
than 150 injections.

Replace with new capillary
array.

Degraded formamide.

Use fresh formamide and ensure
correct storage conditions.

Improper injection and run
conditions.

Notify QA to check default
settings.
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Observation

Possible Cause

Poor resolution in some Insufficient filling of array.
capillaries.

Poor quality water.

Refill array and look for
cracked or broken capillaries. If
problem persists contact
Technical Support.

Use high quality, ultra pure
water.
Replace with fresh running
buffer.
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Water placed in buffer reservoir
position 1.

di
na
to

r

No current

Recommended Action

Elevated current.

Not enough buffer in anode
reservoir.

Add buffer up to fill line.

Buffer is too dilute.

Prepare new running buffer.

Bubbles present in the polymer
block and/or the capillary and /or
peek tubing.

Pause run and inspect the
instrument for bubbles. They
may be hidden in the peek
tubing.
Open fresh lot of polymer and
store at 4oC.

Decomposed polymer.

Incorrect buffer dilution.

Prepare fresh 1X running
buffer.

Arcing in the gel block.

Check for moisture in and
around the septa, the reservoirs,
the oven, and the autosampler.
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Recommended Action
Pause the run, check the
polymer path for bubbles, and
remove them if present.

A slow leak may be present in the
system.

Check polymer blocks and
syringes for leaks. Tighten all
fittings.

Incorrect buffer concentration.

Prepare fresh running buffer.

Not enough buffer in anode.

Add buffer up to the fill line.
Refill capillary array and check
for clogs.
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Clogged capillary.

r

Fluctuating current

Possible Cause
Bubble in polymer block.
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Observation

Arcing.

Poor performance of
capillary array used for
fewer than 150 runs.

Migration time
becomes progressively
slower.

Poor quality formamide

Check for moisture in and
around the septa, the reservoirs,
the oven, and the autosampler.
Prepare fresh formamide and
reprep samples.

Incorrect buffer.

Prepare new running buffer.

Poor quality sample, possible
cleanup needed.

Desalt samples using a
recommended purification
protocol (e.g., microcon).
Tighten all ferrules, screws and
check valves. Replace any
faulty parts.

Leak in the system.

Improper filling of polymer
block.

Check polymer pump force. If
the force needs to be adjusted,
make a service call.

Expired polymer.
If necessary, change the lot of
polymer.
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Observation

Possible Cause

Recommended Action

Water in syringe resulting in
diluted polymer.

Clean the syringe, make sure it
is completely dry OR replace
syringe.

Purging of polymer
from the polymer
reserve syringe.

Arcing in the anode gel block.

Replace lower polymer block.

Bubbles in syringes.

Remove bubbles.

Leaking polymer at the
top of either syringe.

Insufficient seal around the tip of
the syringe plunger.
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Migration time
becomes progressively
faster.
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Do not move the syringe
plunger when it is dry. Make
sure to wet the plunger before
filling the syringe with polymer.
Do not mix and match barrels
and plungers.
Ensure the array ferrule knob is
tightened.

Leaking polymer at the
bottom of the polymerreserve syringe.

Improper tightening of the array
ferrule knob to the syringe and/or
to the polymer block.

Error message, “Leak
detected” appears. The
run aborts.

Air bubbles in the polymer path.

Check for bubbles and remove
if present, then check for leaks.

Pump block system is
loose/leaking.

Make sure all syringes, screws,
and tubing is tightly secure.
Ferrule in capillary end of block
may be positioned wrong or
missing. Check for this ferrule.

Lower pump block has burnt out.
When there is condensation in the
reservoir(s) this will cause
electrophoresis problems and
burn the lower block

Replace the lower block.
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Observation

Recommended Action
Check for bubbles and remove
if present. Then, look for leaks.

Lower polymer block is not
correctly mounted on the pin
valve.

Check to make sure the metal
fork is in between the pin holder
and not on top or below it.

Tightening of the array ferrule
knob at the gel block causes high
tension.

Loosen the array ferrule knob to
allow the secure placement of
the window. Re-tighten and
close the detection door.
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Detection window pops
out while replacing the
capillary array.
Replacing the window
in the correct
orientation is difficult.
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Buffer jar fills very
quickly with polymer.

Possible Cause
Air bubbles in the polymer path.

Detection window
stuck. It is difficult to
remove when changing
the capillary array.

To loosen the detection
window:
a. Undo the array ferrule knob
and pull the polymer block
towards you to first notch.
b. Remove the capillary comb
from the holder in the oven.
c. Hold both sides of the
capillary array around the
detection window area, and
apply gentle pressure equally on
both sides.
d. Release.
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PURPOSE:

To compile the sequence data generated by the ABI 3100 into a project for
analysis, by editing the sequence data and compiling consensus sequences that
can be compared against the revised Cambridge Reference Sequence to determine
the mitochondrial DNA type.

PROCEDURE:

A.
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The data following the 3100 run will be saved on the local 3100 computer in separate injection
folders. These folders, along with the run statistics and the exported run sheet will be saved into
a master file, which will be transported by CD-ROM or USB flash drive to analysis stations.
Samples run in the Big Dye Terminator v3.1 will need to be processed in Sequence Analysis
5.1 for the basecalls to be assigned. Once the files have been processed in Sequence Analysis
5.1, they will be imported into Sequencher for consensus sequence analysis and interpretation of
the mitochondrial DNA type.
Creating a master file for the 3100 run data
1.

On the desktop, click on the shortcut for the respective instrument’s data file. The
main path to this data file is:
E:\Applied Biosystems\UDC\data collection\data\ga3100\Instrumentname
Once there, identify the injection folders of the runs you wish to analyze.

2.

Create a new file using the following format:
“InstrumentnameYear-Run Number Files” (Example: Spiderman04-007 Files)

3.

Move the injection folders into this new file, making sure that all of the run
statistic files and log files are included.

4.

Open the Run Sheets file, select both the .txt and the Excel files for the run and
copy them into the new master file.

5.

Attach the USB memory stick to the USB port of the computer. Once the
computer recognizes the memory stick, copy the newly created master file to the
stick. In the lower right corner, click on the safely remove hardware icon in the
toolbar, select the USB memory stick, and click stop. The computer will tell you
when it is safe to remove the USB memory stick.
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6.

Insert the USB memory stick into the Mitochondrial File-Sharing computer. Drag
the newly created run files into the respective archive files on the desktop. Once a
week, the data from this File-Sharing computer will be backed up.

5.

To access the data on the Mitochondrial File-Sharing computer, open “My
Network Places” on any desktop computer. Open the respective archive file
containing the data to be analyzed, and copy the 3100 run file to the local hard
drive in a designated “sequencing data” file.
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Archiving of 3100 Run Data
1.

After the run in completed on the 3100 instrument, the data from that run must be
archived on the pre-formatted CD-R associated with the instrument. To do this,
insert the CD-R into the CD drive and wait for the 3100 computer to recognize
the disc.

2.

Drag and drop the newly created master run files onto the CD-R. Once all of the
files have been successfully moved, close the CD-R window.

3.

Open the “My Computer” icon. Right click on the CD-ROM drive, and select
“Eject” from the drop down list. The computer will finalize the data and eject the
disc.
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B.

MITOCHONDRIAL DNA SEQUENCING ANALYSIS

Sequence Analysis 5.1
1.

Open the Sequence Analysis 5.1 program by double clicking on the icon. Login
using your username and password.
Note- If the same copy of Sequence Analysis is open on two different
computers connected to the same network, the second computer will not
allow the user to access the program. If necessary, log off the network and
work locally on the computer.

2.

Click on the import samples icon in the upper left of the screen, or go to Add
Sample(s) under the File menu.
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In the new window that pops up, locate the master file of the run that you wish to
analyze. Click on the individual run files within the master file, and for each one
click Add Selected Samples>> at the bottom of the window. As this is done, a
list in the right of the window will populate with the samples from the run. Click
OK when finished importing samples.

4.

The Add Sample Status window will indicate the progress of importing the
samples. When this finishes, the samples will appear in the top window of the
screen. Maximize this area by dragging the center divider bar to the bottom of the
window.

5.

The samples should all have the boxes under BC (base calling) checked. Click on
the Green Arrow at the top of the screen to begin the analysis of the samples.

6.

The Analysis Status window will indicate the progress of analyzing the samples.
As samples are analyzed, the BC column will display a green, yellow, or red box
around the check box indicating the quality of the base calling:
Green:
Indicates a successful base calling for that sample
Yellow:
Indicates a problem in base calling the data for that sample
Red:
Indicates that there is no data to be analyzed for that sample
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3.

All Positive Control samples and Casework samples should be green if the cycle
sequencing was successful.
All Amplification Negative Controls and Extraction Negative Controls should
be yellow or red.
7.

At the right side of the screen are columns of numbers, indicating spacing, peak
1, start, and stop. The numbers under spacing should be black if the spacing is
acceptable (indicated by a green box in the BC column). If the number is red, the
sample should also have a yellow or red box in the BC column. The red numbers
under the spacing should be present for negative control samples.
If a casework sample or positive control sample has a yellow/red box in the
BC column and red numbers in the spacing column, re-analyze the sample
by re-checking the BC column and clicking on the Green Arrow. See
Troubleshooting for further information.
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If the sequencing analysis is successful, click the yellow floppy-disk icon in the
top left of the screen to Save All Samples, or click on Save All Samples under
the File menu.

9.

Print the analysis report page. Click on the Analysis Report button at the top of
the page (white button with AR; A is in red and R in blue), or select Analysis
Report under the Analysis menu at the top of the screen. When the report page
opens, right click on the column headings for the analysis report. Deselect the
following options- PP Status, Peak 1, Base Spacing, # Low QV, # Med QV, #
High QV, and Sample Score. The visible column headings will show the
following- BC Status, Well, Cap #, LOR, ‘A’ S/N, ‘C’ S/N, ‘G’ S/N, ‘T’ S/N,
Avg S/N.

10.

Click the Print icon, and verify that the print settings are on “Landscape.” Click
“Print.” Close the Analysis Report screen.

11.

Repeat the printing of the analysis report page, but this time send the file to
Adobe PDF. Verify that the print settings are on “Landscape.” Click “Print.”
Save the PDF file to the master analysis file for the samples being analyzed,
named for the run itself (eg. Spiderman05-005). Close the Adobe PDF window.

12.

Click Exit under the File menu to close out the Sequencing Analysis program.

13.

The Analysis Report, 3100 Run sheet, and CycSeq worksheet must be copied
for all cases contained in the paperwork, and distributed to the respective analysts.
The original copies will be placed together in the proper 3100 binder for
archiving.

14.

After the Sequencing Analysis is complete, the processed samples files must be
archived back onto the Mitochondrial File-Sharing computer. To do this, ensure
that the Master Run File on the local computer contains the following
information:
• All processed samples
• 3100 Excel Run sheet for that respective run
• Newly created PDF Sequencing Analysis Report
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15.

D.

MITOCHONDRIAL DNA SEQUENCING ANALYSIS

Open the “My Network Places” on the local computer and select the Analyzed
Archive on the Mitochondrial File-Sharing computer. Find and select the Master
Run file on the local computer, and copy it to the Analyzed Archive file on the
Mitochondrial File-Sharing Computer. Once a week, the data from this FileSharing computer will be backed up.

Sequencher

Open Sequencher. Under the Contig menu, select Consensus to Forensic
Standards. This only needs to be done after opening Sequencher for the first
time. Once set, it will remain until the program is closed. Also, check to make
sure that the Assembly parameters used to creat contigs are set to the proper
settings. Click on the box in the upper left-hand corner that is marked “Assembly
Parameters”. The following settings should be selected:
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Before you begin Sequencher, make sure that the USB key is fully inserted in a local
USB port on the computer, and the computer fully recognizes the key. If successful,
the computer will make a “Ding-Dong” sound. Starting Sequencher without this
USB key will cause the program to lock out all editing capabilities.

Assembly Algorithm:
Optimize Gap Placement:

Minimum Match Percentage:
Minimum Overlap:

Dirty Data (radial button)
Use ReAligner (check box)
Prefer 3' Gap Placement (check box)
85% (slide bar)
20 (slide bar)

2.

Under the File menu, go to Import and select Sequences.

3.

Find the sequence files that were copied to the local hard drive. To simplify,
under File of Type select “ABI Files (*.ABI, *.ABD, *AB1).” To select all of the
files, click and drag to highlight the files, or select the first file, press and hold the
Shift key, and click on the last file. Once the files are selected, click Open.
Maximize the analysis window to view all of the samples and sample data.

4.

Import the appropriate reference sequence into the project for every contig that
needs to be built. The reference files (HVI.spf or HVII.spf) are located on the
Forensic Biology network.
These files can be saved to the desktop or local hard drive for easier access.
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Holding down the Shift key, click on imported rCRS file, and the forward and
reverse sequence files that will make up the contig.

6.

At the top of the screen, click on the Assemble to Reference button. If the
samples contain viable data, the contig will be formed. If the samples do not
contain quality data, they will not import into the contig. Name the contig
according to the sample name and hypervariable region sequenced. (e.g.- Hair 1A
HVII)

7.

Select the new Contig icon by clicking on it once. In the Contig menu at the top
of the screen, select Trim to Reference Sequence.

8.

Double click on the Contig icon. When the contig diagram window opens, click
on the Bases button at the top left of the screen.
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5.

A new window will open showing the individual sequence files above the
rCRS reference sequence at the top of the window and the consensus
sequence at the bottom of the window. Individual sequences, including the
reference sequence can be moved up or down by placing the cursor on the
name of the sequence in the upper left box and dragging the sequence up or
down.
Under the consensus sequence is a series of “•” and “+” symbols. The “•”
symbols highlight base call disagreements from the rCRS and the “+”
symbols highlight ambiguities in the consensus sequence.
9.

To view the chromatogram data and the sequence data together, highlight a base
in the consensus sequence and click the Show Chromatograms button at the top
of the screen. This will open a second window showing the chromatogram data
for all of the sequences in the contig. Notice that the reverse primer sequence has
been reversed and compiled in the process of building the contig. Adjust the
position of the two screens so that all of the sequence data is visible along with
the chromatogram data, and so all of the base positions can be reviewed. Use this
display and review all sequence positions.
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10.

To quickly move from one ambiguity to the next in the consensus sequence, click
on the first base in the sequence and then press Control-N simultaneously on the
keyboard. This will jump both the sequence data and chromatograms to the next
ambiguous position. To find only the instances where the contig is in
disagreement between the strand data, click on the sequence data and press
Control-D.

To edit a base call, click on the base in question in the consensus sequence or
individual sequence, and press the appropriate letter on the keyboard according to
the following:
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IMPORTANT- In the instances where length heteroplasmy is present and
yields single-stranded DNA regions and/or ambiguous, un-editable N calls
are present, the consensus setting on the Sequencher program must be set to
Plurality mode to analyze that particular sample.

IUPAC Codes *
R- A or G
Y- C or T
K- G or T
M- A or C
S- C or G
W- A or T
*See Nomenclature section of this manual for further discussion.

Standard Codes
A- Adenine
C- Cytosine
T- Thymine
G- Guanine
N- Ambiguous

All edits must be documented on the mtDNA Sequence Analysis Editing
Sheet.
12.

To delete a base, click on the base in question and do one of the following:
a.
b.

13.

To have the bases fill in from the left side of the strand, press the delete
key.
To have the bases fill in from the right side of the strand, press the
backspace key, and follow the on-screen instructions.

To insert a base, press the Tab key and follow the on-screen instructions.
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To shift the entire strand, place the cursor over the strand in question and press
and hold the Ctrl key. The cursor will turn into a open hand icon. Click and hold
using the icon and the hand will “grab” the strand, allowing you to move the
entire strand left or right.

15.

To move a single base, place the cursor over the base in question and press and
hold the Alt key. The cursor will turn into a lasso icon. Click and hold using the
icon and the lasso will “grab” the base, allowing you to move the base.

16.

To highlight a section of the sequence, click on the beginning base in the
sequence you wish to highlight, and then move the cursor to the last base in the
sequence section, press and hold the Shift key, and click on the final base.

17.

When the sequence review and the editing are completed, go to the Contig menu
and click on Difference Review. Print this sheet out in portrait orientation. To
do this, select the File menu and select Print Setup. Select portrait as the
orientation, and print to the Lexmark C720 printer from the drop-down list.
Click OK. Under the File menu, select Print. Confirm that the Lexmark C720
printer is selected and click Print.

18.

Print the Difference Review page again, but this time send the file to Adobe
PDF. Click Print. Save the PDF file in the master run file, named as the sample
name plus “diff,” eg. “FB05-0005m hair 1 HVI diff.” Close the Adobe window.
Close the Difference Review window.

19.

At the top of the sequence comparison page, click on the Summary button.
When the Summary View window opens, click on the Ruler button at the top of
the page and adjust the right-margin triangle (=) so that four columns are visible
(drag the triangle to the extreme right edge of the ruler under the number 8).
Click the Ruler button again to hide the ruler.

20.

Print the Summary page. To do this, select the File menu and select Print
Setup. Select portrait as the orientation, and print to the Lexmark C720 printer
from the drop-down list. Click OK. Under the File menu, select Print. Confirm
that the Lexmark C720 printer is selected and click Print.

21.

Print the Summary page again, but this time send the file to Adobe PDF. Click
Print. Save the PDF file in the master run file, named as the sample name plus
“sum,” eg. “FB05-0005m hair 1 HVI sum.” Close the Adobe window.
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22.

Click on the Overview button. In the Contig Diagram, double click on the
individual sequence files. The sequence window of the file will open. Click on
the Show Chromatogram button at the top of the screen. A new window will
open. In the upper left corner is a slider bar, the four-color bases and two buttons:
a dot and a vertical bar. DO NOT CLICK THE VERTICAL BAR, AS THIS
WILL ERASE THE HEADER FROM THE PRINTED PAGE.

Print this chromatogram as edited data, trimmed to the hypervariable region of
interest. To do this, select the File menu and select Print Setup. Select
landscape as the orientation, and print to the Lexmark C720 printer from the
drop-down list. Click OK. Under the File menu, select Print.

Ar
D ch
oc iv
um ed
en 07
t C /24
on /2
tro 01
lC 0
oo
r

23.

di
na
to

r

NOTE: Printing of the chromatograms is not always necessary, and should
only be done when needed for the casefile. If the chromatograms do not need
to be printed, skip step 23.

a.

b.

If you are printing the forward strand, under Page Range select the
FIRST four (4) pages of the chromatogram.
If you are printing the reverse strand, under Page Range select the LAST
four (4) pages of the chromatogram.

Confirm that the Lexmark C720 printer is selected. Click Print.
Repeat step 23 for every separate chromatogram file.
24.

Create an Adobe PDF file for this chromatogram as edited data, trimmed to the
hypervariable region of interest. To do this, select the File menu and select Print
Setup. Select landscape as the orientation, and print to Adobe DPF from the
drop-down list. Click OK. Under the File menu, select Print.
a.

If you are printing the forward strand, under Page Range select the
FIRST four (4) pages of the chromatogram.

b.

If you are printing the reverse strand, under Page Range select the LAST
four (4) pages of the chromatogram.
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Confirm that the Adobe PDF is selected, and click Print. Save the PDF file in
the master run file, named as the sample name plus the primer, eg. “FB05-0005m
hair 1 HVI A4.” Close the Adobe window.
Repeat step 24 for every separate chromatogram file.
Return to the Contig Diagram window.

26.

The lines at the top of the diagram indicate the forward and reverse strands in
relation to the rCRS sequence, and the green bar below the lines indicates which
areas of the rCRS are covered by the available sequence data. If the sequence is
present in both the forward and reverse strand, the bar will be green with thin
white strips on the top and bottom. If there is a partial coverage in only one
direction, the bar will contain a light blue pattern.

27.

Print out the Contig Diagram. Under the File menu, select Print Setup. Select
landscape as the orientation, and print to the Lexmark C720 printer from the
drop-down list. Click OK. Under the File menu, select Print. Confirm that the
Lexmark C720 printer is selected and click Print.

28.

Print the Contig Diagram page again, but this time send the file to Adobe PDF.
Select landscape as the orientation, and click Print. Save the PDF file in the
master run file, named as the sample name plus “map,” eg. “FB05-0005m hair 1
HVI map.” Close the Adobe window.

29.

Save the project file, and close and exit the Sequencher program.

E.
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25.

File Output and Construction

Arrange the paperwork in following order, from bottom to top:
a. Sequencher Chromatogram printouts (if necessary)- landscape
b. Contig Diagram- landscape
c. Summary View- landscape
d. Editing Sheet
e. Difference Review- portrait
Landscape pages should be arranged in the file so that the right side of the landscape
view faces the top edge of the file, and the left side of the landscape view faces the
bottom side of the file. Staple the top left corner.
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Archiving the Sequencher Data
1.

After the Sequencher analysis is complete, the project and all of the original 3100
run data must be archived back onto the Mitochondrial File-Sharing computer.
To do this, create a new file in “Sequencing Data” file on the local analysis
computer for the case that is to be archived (e.g.- FB05-0005).

2.

Drag and drop the Sequencher project and all associated 3100 run data files into
the newly created file on the local computer. Once all of the files have been
successfully moved, close the file.

3.

Open the “My Network Places” on the local computer, and select the Project
Archive on the Mitochondrial File-Sharing computer. Select the newly created
file, and copy it to the Project Archive file on the Mitochondrial File-Sharing
Computer. Once a week, the data from this File-Sharing computer will be backed
up.
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F.

MITOCHONDRIAL DNA SEQUENCING ANALYSIS

Data Review
1.

Once all of the Sequencher data has been completed and the file have been
archived, pass the entire set of sample printouts for one 3100 run to another IA for
data review.

2.

For the IA performing the review, the following steps must be performed.
a.

On the Mitochondrial File-Sharing computer, open the respective file from
the Project Archive by copying the file to your local hard-drive. Review
the Sequencher contigs.

b.

For each sample, ensure that all edits reflected on the editing sheet are
valid and accounted for within the data set.

c.

For positive controls, ensure that the proper type is displayed on the
Difference Review page.

d.

For negative controls, open the bases and chromatogram windows for each
primer for each sample to ensure that no base calling data is present. If
necessary, attempt to re-build a contig using questionable negative
controls.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.
All printed versions are non-controlled copies.

PROTOCOLS FOR FORENSIC MITOCHONDRIAL DNA ANALYSIS
13.

MITOCHONDRIAL DNA SEQUENCING ANALYSIS

DATE EFFECTIVE

VERSION

PAGE

04-08-2005

2.0

12 OF 12

e.

Ensure for every sample that the paperwork is assembled in order and
reflects the entire project and sample names.

3.

If a problem is found, mark the occurrence within the paperwork and return the
paperwork to the original analyst.

4.

Delete the copy of the imported project file from the local computer.
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DO NOT SAVE THE PROJECT FILE BACK TO THE
MITOCHONDRIAL FILE SHARING COMPUTER.
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Nucleotide positions are designated according to the standard one-letter code based on
the nomenclature system adopted by the International Union of Pure and Applied
Chemistry (IUPAC; see table below). Note that an “N” is used to denote unresolved
sequence ambiguities where N can be any one of the four bases. IUPAC codes that
designate two possible bases should only be used in instances of sequence
heteroplasmy.
Base designation

IUPAC code

Base designation

G

Guanine

R

A or G

A

Adenine

T

Thymine

C

Cytosine

N

G, A, T, or C
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IUPAC code

Y

C or T

K

G or T

M

A or C

S

C or G

W

A or T
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1.

SEQUENCE NOMENCLATURE

Sequence differences between the questioned sample and the revised Cambridge
Reference Sequence (rCRS) are generated and printed out from the Difference Review
file in Sequencher. These differences are organized by hypervariable region (eg., one
difference review file is generated for each HVI and HVII region). The differences are
listed in order of occurrence on the mtDNA molecule as shown below. “Ref” (reference)
and “Con” (consensus) indicate what bases are present in the rCRS and the questioned
sample, respectively, at the designated mtDNA sequence positions.
2 differences between rCRS 00073-00340 and (sample name) HVII
Pos
263
301
315.1

Ref
A
A
:

Con
G
:
G

Required Edit
Change base
Delete base
Insert base
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In most cases, the alignment of a given mtDNA sequence with that of rCRS is
straightforward. However, care must be taken in the placement of insertions and
deletions in reference to that of rCRS according to the following standard nomenclature:
a.

Characterize profiles using the least number of differences from the reference
sequence.

b.

If there is more than one way to maintain the same number of differences with
respect to the reference sequence, differences should be prioritized in the
following order: (i) insertions/deletions, (ii) transitions, and (iii) transversions.

c.

Insertions and deletions should be placed furthermost 3', with respect to the light
strand of rCRS. Insertions and deletions should be combined in situations where
the same number of differences to the reference sequence is maintained.
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3.

SEQUENCE NOMENCLATURE

4.

Insertions should be listed to the right of a particular nucleotide position. Insertions are
notated by first noting the site immediately 5' to the insertion followed by a point and a
“1” for the first insertion, a “2” if there is a second insertion, and so on.

5.

Deletions should be listed exactly where the known base in the reference sequence is
missing in the sample sequence to minimize the number of differences between the
questioned sample and the rCRS reference sequence. Deletions are noted by a “:” in the
consensus sequence.

6.

Sequence heteroplasmy (also known as point or site heteroplasmy) occurs when a single
sample contains at least two mtDNA sequences that differ at one or two nucleotide
positions. The appropriate one-letter IUPAC code will be used during the editing of a
given site that shows sequence heteroplasmy. This designation will be reflected in the
Difference Review. In addition, the presence of sequence heteroplasmy at the given
nucleotide position for the respective heteroplasmic bases will be documented on the
editing sheet.
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Length heteroplasmy occurs in regions that contain many tandem C nucleotides. These
regions are commonly referred to as polycytosine or C-stretch regions. Length
heteroplasmy refers to a sample that has at least two types, each one differing by the total
number of C nucleotides at a given C-stretch.
a.

It will be noted if a given casework sample has length heteroplasmy in HVI.
The number of C residues, however, in the area with HVI length heteroplasmy
will not be recorded. Length heteroplasmy in HVI most commonly arises when
there is a substitution of a C for a T at position 16,189. The reference type in HVI
is C5TC4. Sequences showing length heteroplasmy in HVI will be truncated to fit
the C5TC4 format including the T to C change at position 16,189.

b.

It will be noted if a given casework sample has length heteroplasmy in HVII.
Length variants in HVII are commonly observed in the number of C residues
preceding a T residue at position 310. It is often possible to determine
unambiguously the dominant length variant in this region. The profile used for
further analysis in Sequencher should be composed of only the major type as
determined by the analyst.
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7.

SEQUENCE NOMENCLATURE
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Sequencher base calls can be modified if the underlying data support it. The analyst can change
an “N” call into a base determination, insert an additional base, or remove a position. A base call
must not be edited without proper justification.
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Reasons for base insertion are:
- Base omitted however authentic peak is present
- To maintain proper spacing

r

Reasons for base removal are:
- Extra base inserted due to broad peak, peak artifact, or analysis default spacing
- Trimmed to remove end sequence (sequence tail removal)
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Reasons for changing a base to an “N” or to a degenerate IUPAC code are:
- Ambiguous bases are detected
- Dye or electrophoretic artifact interference
- Due to sequence or length heteroplasmy
Reasons for changing an “N” call to a base is:
- Base omitted or called “N”, however authentic peak is present
- Dye artifact or electrophoretic interference
- Neighboring peak interference

Many software ambiguities are easily resolved by the analyst. However, ambiguous situations
should not be edited. If an electrophoresis problem is suspected, this sample should be reinjected. Sequence information at each base position should be confirmed by data from both
DNA strands when possible. Single-stranded regions present due to length heteroplasmy, must
be confirmed by sequencing the same strand in the same direction in an independent cycle
sequencing reaction. The Sequencher complementary strand alignment will flag conflicts
between the two sequencing directions for all strands imported into the contig.
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When all of the sequencing analysis is completed for a case, and the case file is submitted
for review, a CD-R containing all of the data for that case must be created and stored
within the case file.
1.

Insert a blank CD-R into the computer, and open the program “Nero Smart Start.” Click
on the page-shaped icon for “Data,” and select “Make Data CD.”

2.

The levels of the disc will be created according to the following:

Ar
D ch
oc iv
um ed
en 07
t C /24
on /2
tro 01
lC 0
oo
r

di
na
to

r

CD-R Main Window
- All Sequencher Project Files (identified “Evidence” or “Exemplars”)
- “Reports” File
- Mitochondrial Laboratory Report
- Population Statistics files
- “Evidence” File
- All analyzed 3100 Run Files
- Analyzed 3100 data files
- 3100 Excel sheet & Text File
- Sequence Analysis Report
- “PDF Evid” file
- All PDF forms from analysis
- “Forms Evid” file
- Any worksheet that was generated electronically
in its entirety
- “Exemplars” File
- All analyzed 3100 Run Files
- Analyzed 3100 data files
- 3100 Excel sheet & Text File
- Sequence Analysis Report
- “PDF Exemp” file
- All PDF forms from analysis
- “Forms Exemp” file
- Any worksheet that was generated electronically
in its entirety
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Click on the “Add” button on the right of the screen, and import the necessary files
according to the tree structure above. Ensure that all 3100 data is imported from the
Analyzed Archive on the Mitochondrial File Sharing computer, NOT the 3100 archive.

r

To ensure the quality of the disc, it is advisable to copy all of the necessary data to a
single location on the local computer that will create the CD-R. Once all of the
necessary files have been compiled in this file on the local hard drive, according to
the tree structure above, the entire contents of the local file can be added to the Nero
Express window by Drag-and-Drop.
Once all of the necessary files have been compiled, click the “Next” button at the lower
right of the screen. For the Disc Name fill in the casefile number, (eg. FB05-0234).
Make sure that the boxes are checked for the “Allow files to be added later (multisession
disk)” and for the “Verify data on disc after burning.” Click “Burn.”

5.

When the message “Data verification completed successfully” is displayed, click “OK.”
Click “Next.”

6.

When finished, the program will ask the user if the format for the new disc is to be saved.
Click “No.” Click “Exit” to close the program.

7.

Label the new disk with the casefile number, and initial and date. Secure the CD-R
inside the respective casefile.

8.

Any archived data copied to the local computer should be deleted, and SHOULD NOT
be copied back to the archive file.
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GUIDELINES FOR CONTROLS
A.

Negative controls

r

Negative controls are considered negative if there is no detectable band on the product
gel and no signal is seen after 3100 electrophoresis. For DNA sequencing analysis, the
controls are also considered negative if signals were obtained, but the resulting base calls
fail to form a contig in Sequencher analysis: that is to say there is either no “readable”
sequence present or any sequence that is there cannot align to the reference sequence.

Ar
D ch
oc iv
um ed
en 07
t C /24
on /2
tro 01
lC 0
oo
r

di
na
to

Two negative controls are associated with each sample: the extraction negative (e neg)
and the amplification negative (amp neg) controls. The former tests for potential DNA
introduced during the extraction through the amplification steps, while the latter tests for
the presence of any background DNA that was introduced during the amplification step
or present in the amplification reagents. Both of these controls need to be processed for
all sequencing primer sets.
Decision matrix for passing, failing or retesting negative controls is as follows:
1.

Product gel

Control

Result

Amplification
negative

No signal

Extraction
negative

No signal

Action required

Controls pass this stage; proceed with
linear array and sequencing analysis.
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Control

Result
No signal

Extraction
negative

Band seen
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Amplification
negative

Action required
Re-amplify extraction negative to confirm
presence of DNA, samples can proceed if
re-amplification is clean. If the extraction
negative control still yields a band
following re-amplification, it is preferable
to re-extract this sample if more sample is
available.
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If sample amount is limiting, analyst may
proceed with caution (see comments listed
for this scenario in Sequencing results
section). However, if the amount of DNA
present in the extraction negative sample
exceeds 10% of any associated sample,
that sample is invalid.

The first extraction negative may be
sequenced for quality control purposes.

Amplification
negative

Extraction
negative

Band seen

No signal

This sample set should be re-amplified.
This is preferable.

Since this result indicates that the
background DNA is limited to the
amplification control tube rather than
being ubiquitous in all samples, it is left to
the analyst’s discretion to proceed with
this amplification set if no additional
sample or e neg extract are available.
If the amount of DNA present in the amp
neg exceeds 10% of any associated
sample, that sample is invalid. In addition,
the results are only valid if the sequence
detected for the amp neg does not match
any of the samples in the case
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Control
Amplification
negative

Band seen

Extraction
negative

Band seen

Action required
Amplification fails and samples must be
re-amplified. The negative controls may
be sequenced for quality control purposes.

Sequencing results
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2.

Result
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If an extraction or amplification negative control contains a sequence that matches
a case sample, then the test fails and retesting must start at the point of sample reextraction or amplification, respectively. The determined sequence for the
extraction or amplification negative control must contain at least 100 bp or more
of readable sequence in order to be used in sequence comparisons with case
samples.
Control

Result

Action required

Amplification
negative

Negative

Extraction
negative

Negative

Amplification
negative

Negative

The fact that some of the sequencing
primers did not yield a result indicates
that the level of PCR product
contamination is very low.
Reamplification and re-sequencing of the
extraction negative may be performed to
ensure that the contamination is present.

Extraction
negative

Readable
sequence for
some but not all
primers

Depending on the amount of original
sample present, analyst may choose to reextract the sample.

Controls pass this stage; proceed with
interpretation and/or sequencing analysis.

Sample results for the affected primer
set, however, can be interpreted and
reported if the sequence is different from
all case samples.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.
All printed versions are non-controlled copies.

PROTOCOLS FOR FORENSIC MITOCHONDRIAL DNA ANALYSIS
17.

INTERPRETATION GUIDELINES

DATE EFFECTIVE

VERSION

PAGE

04-08-2005

2.0

4 OF 9

Negative

If more DNA extract is available, it is
preferable to re-amplify and re-sequence
this sample.

r

Readable
sequence for
some but not all
primers

Action required
The fact that some of the sequencing
primers did not yield a result indicates
that the level of PCR product
contamination in the amp neg is very
low.

If the DNA extract is limiting or reamplification yields the same results,
then sample results for the affected
primer set can be interpreted and reported
if the sequence is different from all case
samples.
If possible, repeat extraction and testing
of samples.
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Extraction
negative

Result
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Control
Amplification
negative

Amplification
negative

Negative

Extraction
negative

Readable
sequence for all
primers

Amplification
negative

Readable
sequence all
primers

Extraction
negative

Negative

Reamplification and re-sequencing of the
questionable extraction negative may be
performed
to
ensure
that
the
contamination is indeed present.
If no sample is available for retesting, the
results can be interpreted and reported if
the sequence is different from all case
samples.
If possible, repeat amplification and
testing of samples.

If no sample and Extraction negative
extract is available for retesting, the
results can be interpreted and reported if
the sequence is different from all case
samples.
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Amplification
negative

Readable
sequence for
some or all
primers

Extraction
negative

Readable
sequence for
some or all
primers

Action required
The extraction negative cannot be
interpreted because the amplification
may have introduced a contaminant. The
test fails and all samples and the
Extraction negative must be re-amplified
and re-sequenced.

r

Result
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Control

B.
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NOTE: If it is necessary to re-sequence a casework sample from the cycle
sequence step, a new amplification negative control must be created for this
round of cycle sequencing. This negative control must yield a negative result
for the results to be valid.

Positive controls

The positive control (HL60) is included for each amplification and must produce
sequence that is consistent with the known polymorphisms. The positive control sample
must yield results for the full read length of 16024-16365 and 73-340. In addition, the
positive control serves as the run control. Therefore, in order to be valid, every run must
have a positive control that passes specification.
The known polymorphisms in comparison to the rCRS are as follows:
HVI
16,069
16,193
16,278
16,362

T
T
T
C

HVII
73
150
152
263
295
315.1

G
T
C
G
T
C
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If the positive control fails to produce the expected result, all samples associated with this
control fail. If it is suspected that the problem is not related to the amplification but could
stem from a subsequent step, the positive control and all of the samples can be retested
starting either at the cycle sequencing or the 3100 injection step.
In cases of dye interference or electrophoretic artifact, some N calls in the positive
control will be allowed as follows:
A maximum number of 3 N’s (~ 1% of total HVI or HVII sequence) will be
allowed for either HVI or HVII region provided that the calls on the
complementary strand are unambiguous and not contradictory to the questioned
nucleotide position(s).

2.

Any positions that have ambiguous N calls on both complementary strands that
cannot be resolved through a repeat injection will result in the failing of the
positive control and all of the associated sample runs.
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1.

GUIDELINES FOR REPORTING
A.

Reporting of Base Calls
1.

Sequence data should be determined from both complementary strands of DNA
for mtDNA regions HVI and HVII.
a.

All good quality data that shows concordance for both complementary
DNA strands can be reported. A list of reported differences from the
rCRS must be accompanied by the read length of the region that was
sequenced.

b.

For sequence where an ambiguous calling situation occurs for one of the
complementary strands, it must be left unresolved and called an “N”.

c.

If an ambiguous “N” base call is made on one of the DNA strands (eg.,
due to an electrophoretic artifact), this base can still be reported as long as
(i) the data on both strands are not in conflict with each other, and (ii) the
data generated from the complementary DNA strand is clean and there is
no question regarding its base call. No more than 3 un-editable N calls
are acceptable within a contiguous 10 base stretch of data. If so, the
reaction should be repeated.
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Unambiguous data from both complementary DNA strands are required in
order to report a difference from rCRS or sequence heteroplasmy. Only
under special circumstances (see below) can data be reported for singlestranded regions of DNA.

e.

A minimum read length of 100 contiguous base pairs of double-stranded
or confirmed data that forms a contig will be valid for interpretation and
for generating weight assessment. Any strand with less than 100
contiguous bases will be deemed inconclusive.

r

d.

Special circumstances will arise (eg., length heteroplasmy) when data from only
one DNA strand can be obtained.

b.

3.

For samples with HVI or HVII length heteroplasmy, additional primers
should be used in order to obtain as much complementary data as possible.
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2.

B.

INTERPRETATION GUIDELINES

For sequence where no data is available for one of the complementary
strands, this can still be reported given that the sequencing reaction that
yielded the one strand of sequence data is repeated (confirmed) for this
sample with the same or different primer in the same direction. All of the
data from this region (eg., results from two independent cycle sequencing
reactions) must be clean and concordant between the two sequencing runs.
Note: This type of rerun will satisfy conditions where a difference from
rCRS or sequence heteroplasmy is being reported.

In situations when un-editable “N” base calls are made at a given sequence
position for both DNA strands, then this base will be reported as “N”. Samples
with more than 3 un-editable “N” calls within a 10 base pair region in either
HVI or HVII are inconclusive and if possible should be repeated, or the data
should be.

Criteria for Mixture Recognition
1.

More than two heteroplasmic positions in a sample are suggestive of a DNA
mixture. If possible, the sample should be re-extracted or other samples in the
same case should be tested.

2.

Samples that contain two heteroplasmic positions might warrant further testing of
additional samples depending on the circumstances of the case. This is to make
sure that the sample type in question is not due to a mixture.
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Sequence Comparisons
1.

The positive control run with that sample must type correctly in order to report the
sequence for that sample.

2.

If either extraction or amplification negative controls contain readable sequences,
the associated case sample(s) must be compared to this data before any further
sequence comparisons are made. The readable extraction or amplification
negative controls must differ from all case samples by at least two bases for these
controls to be valid. It can then be concluded that the sample DNA source(s) is
not the contaminating DNA and is valid for sequence comparison.

3.

When comparing sequences obtained from samples, only the regions in common
will be considered.

4.

A specimen that yields a mixture of DNA sequences is reported as inconclusive.
No comparisons and no statistical evaluation will be performed using this sample.

5.

The number C nucleotides at the HVI polycytosine C-stretch will not be
considered for interpretation purposes if length heteroplasmy is present. Likewise,
the number of C residues exhibited in samples with HVII length heteroplasmy is
highly variable and care must be taken when making comparisons. In order for
sequence concordance to be declared, a common length variant must be observed
in both samples being compared.
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C.

INTERPRETATION GUIDELINES

Differences in sequence due to the absence of a common length variant are
exclusionary.
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6.

Match Criteria for Sequencing data

The resulting comparison will be considered inconclusive
when two mtDNA sequences from separate samples differ by
one difference.

Exclusion

7.

In these cases other reference sources and/or further testing in
order to obtain more sequence data may be helpful.
The resulting comparison will be considered an exclusion
when two mtDNA sequences from separate samples differ by
two or more differences.
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Concordance

When two mtDNA sequences from separate samples (e.g. from
two pieces of evidence or from evidence and a maternal family
reference source) are consistent with each other in the
overlapping regions, the two samples cannot be excluded as
originating from the same person or from having a maternal
relationship, respectively.

Treatment of sequence heteroplasmy

Two identical heteroplasmic bases are present
at the same position in both samples.

This is not a difference (eg.,
C/T vs. C/T).

One heteroplasmic base is present in one
sample; a common base is present at the same
position in the other sample.

This is not a difference (eg.,
C/T vs. C; also C/T vs. T).

One heteroplasmic base is present in one
sample; a different base is present at the same
position in the other sample.

This is a difference (eg., C/T
vs. G).
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For sequencing data, the laboratory will adopt the database and the procedure suggested by the
FBI.
1.

Database
The database that is being used to obtain a frequency estimate is maintained by the FBI
(Budowle et al 1999, Monson et al 2002) and is available for download at the following
web address: http://www.fbi.gov/hq/lab/fsc/april2002/mtDNA.htm.

2.
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A copy of the database including the search window will be maintained on all mtDNA
analyst computers. The database contains HVI (16024-16365) and HVII (73-340)
sequences from a variety of individuals of Asian, African or European ancestry. The
database will be updated upon release of new versions.

Searching Profiles

The base pair range of the profile to be searched is limited to the shortest range of
reported sequence in common for both compared samples (see previously discussed
reporting criteria)
Click on the mtDNA icon on your screen. The search window will open. Several options
are pre-selected as indicated below.
Mode:
Database:

- search
- forensic

Under options (in edit menu):
Listing profiles:
- not checked
Length variants:
- consider multiple insertions as individual differences
Partial profiles:
- not checked
Statistics:
- display up to 2 differences
Listing haplotypes:
- check to list haplotypes that appear multiple times
Date:
- check “all profiles”
Heteroplasmic scenarios:
- not checked
Helper Apps:
- load Internet Explorer, Excel, and Word
Enter your profile ID.
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Enter the searchable basepair range for HVI and click Add. Repeat for HVII. If your
sample has the standard read length (see above) just double-click on the HVI or HVII
icons. Enter all differences from the rCRS.
Click search.
Select a directory and name for the results file.
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The search result consists of the number of samples with 0-2 mismatches to the searched
sample in the combined database and divided into the different ethnic groups.

3.
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ATTENTION: Even though an HVII polycytosine length variant is entered, these
C-stretch positions are ignored during the database searches of concordant
sequences containing this region and will not add additional rarity. In addition, the
number of C residues in samples with HVI length heteroplasmy are not considered
for comparison purposes.

Frequency estimate
a.

Frequency estimate when the mtDNA sequence is observed at least once in
database.
Raw frequency estimates for the occurrence of a given mtDNA profile in the
general population are based on the counting method as follows:
p = x/N (eq. 1)

Where p is the frequency estimate; x is the number of times a profile has
been observed in the population database, and N is the number of profiles
in the population database.

A confidence interval must be calculated from the results of the database search in
order to correct the counting results for sampling errors according to the following
equation:
p ± 1.96 [(p) (1-p)/N]1/2 (eq. 2)
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The upper 95% confidence interval value (upper bound =
p + 1.96 [(p) (1-p)/N]1/2) is presented as the maximum frequency of individuals
within each population who are estimated to be included as potential contributors
of a questioned profile.
The upper bound estimate can be calculated automatically using the POPSTATS
spreadsheet (Filename: popstats.xls) found on the Forensic Biology network
drive, in the Mitochondrial DNA folder.
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Example #1: The mtDNA sequence is observed 3 times in the mtDNA database
containing 2000 sequences. The frequency estimate is 3/2000 = 0.0015; the upper
bound of the confidence interval is equal to 0.0015
+1.96[(0.0015)(0.9985)/2000]1/2 = 0.0015 + 0.0017 = 0.0032.
Meaning of example #1: With 95% confidence, the maximum true frequency of
the mtDNA profile is 0.0032 or 0.32%. In other words, at least 99.68% of the
population can be excluded as the source of the evidence.

b.

Frequency estimate when mtDNA sequence is not observed in the database.
The following equation is used when a mtDNA sequence profile is not found in
the database:
1 - α 1/N (eq. 3)

α is the confidence coefficient (use 0.05 for a 95% confidence interval),
and N is the number of individuals in the population.

The upper bound estimate can be calculated automatically using the POPSTATS
spreadsheet (Filename: popstats.xls) found on the Forensic Biology network
drive, in the Mitochondrial DNA folder.
Example #2: The mtDNA sequence is observed 0 times in the mtDNA database
containing 2000 sequences. The frequency estimate is 1-0.051/2000 = 1-0.999 =
0.001.
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Meaning of example #2: For a database size of 2000 sequence profiles, the
frequency of a mtDNA sequence profile not observed in the database is 0.001 or
0.1%; or, with 95% confidence, 99.9% of the population can be excluded as being
the source of the evidence.

The mtDNA population database search software will supply separate results
of the frequency estimates for the four major population groups in the U.S.
(African American, Hispanics and Caucasians, and Asians).
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c.
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HVII

1

Nucleotide (base) Sequence

Size (no. of bases)

5'- CAC CAT TAG CAC CCA AAG CT -3'

20

A4

5'- CCC CAT GCT TAC AAG CAA GT -3'

20

B1

5'- GAG GAT GGT GGT CAA GGG AC -3'

20

B4

5'- TTT GAT GTG GAT TGG GTT T -3'

19

HVIF

5'- CTC CAC CAT TAG CAC CCA A -3'

19

HVIR

5'- ATT TCA CGG AGG ATG GTC -3'

C1

5'- CTC ACG GGA GCT CTC CAT GC -3'

20

C2

5'- TTA TTT ATC GCA CCT ACG TTC AAT -3'

24

r

A1
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Region

18

D1

5'- CTG TTA AAA GTG CAT ACC GCC A -3'

22

D2

5'- GGG GTT TGG TGG AAA TTT TTT G -3'

22

HVIIF

5'- CAC CCT ATT AAC CAC TCA CG -3'

20

HVIIR

5'- CTG TTA AAA GTG CAT ACC GC -3'

20

Nucleotide sequences for primers A1, A4, B1, B4, C1, C2, D1, and D2 are from the FBI Laboratory DNA Analysis
Unit II Mitochondrial DNA Analysis Protocol (mtDNA Protocol Manual, DNA Amplification - Rev. 8, Issue Date
02/01/05 for primers A1, B1, C1, C2, D1, and D2; mtDNA Protocol Manual, Cycle Sequencing - Rev. 8, Issue Date
09/10/04 for primers A4 and B4). The primer sequences in the FBI mtDNA Protocol Manual are based on those
described in the following:
Wilson MR, DiZinno JA, Polanskey D, Replogle J, Budowle, B. Validation of mitochondrial DNA sequencing for
forensic casework analysis. Int J of Leg Med 1995; 108:68-74.
Wilson MR, Polanskey D, Butler J, DiZinno JA, Replogle J, Budowle B. Extraction, PCR amplification, and
sequencing of mitochondrial DNA from human hair shafts, BioTechniques 1995; 18(4):662-669.
Nucleotide sequences for oligonucleotide primers HVIF, HVIR, HVIIF, HVIIR are from the product insert for the
LINEAR ARRAY Mitochondrial DNA HVI/HVII Region-Sequence Typing Kit that is available from Roche
Applied Sciences (Cat. No. 03-527-867-001; product information is available at www.roche-applied-science.com).
The primer sequences in the typing kit are based on those described in:
Gabriel MN, Calloway CD, Reynolds RL, Primorac D. Identification of human remains by immobilized sequencespecific oligonucleotide probe analysis of mtDNA hepervariable regions I and II. Croat Med J 2003; 44:293-298.
Kline MC, Vallone PM, Redman JW, Duewer DL, Calloway CD, Butler JM. Mitochondrial DNA typing screens
with control region and coding region SNPs. J Forensic Sci 2005; 50:377-385.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.
All printed versions are non-controlled copies.

PROTOCOLS FOR FORENSIC MITOCHONDRIAL DNA ANALYSIS
APPENDIX B – MITOCHONDRIAL DNA PRIMER LOCATIONS4
1 OF 1

73

340

PAGE

2.0

16365

VERSION

04-08-2005

16024

DATE EFFECTIVE

0

HVII – 268 bp

HVI Primers

HVII Primers

HVIF
A1

di
na
to

HVIIF
C1

r

HVI – 342 bp

C2

Ar
D ch
oc iv
um ed
en 07
t C /24
on /2
tro 01
lC 0
oo
r

A4
B4

D2
D1

B1

HVIIR

HVIR

HVI (16024 - 16365) = 342 bp

Position1

Primer
HVIF

HVII (73 - 340) = 268 bp
Position1

Primer

15975

HVIIF

15

15978

C1

29

A42

16190

C2

154

B42

16182

D23

306

B1

16410

D1

429

HVIR

16418

HVIIR

429

A1

1

Nucleotide position is defined as the first base at the 5’ end of the primer.
Primers A4 and B4 are used to resolve C-stretch length polymorphisms in HVI.
3
Primer D2 is used when necessary to resolve the reverse strand sequence when C-stretch polymorphism is present in HVII.
4
The above diagrams are not to scale. All primer positions are relative to the table below. All arrows indicate the directions (forward
or reverse) that the primer amplifies along the hypervariable region.
2

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.
All printed versions are non-controlled copies.

PROTOCOLS FOR FORENSIC MITOCHONDRIAL DNA ANALYSIS
APPENDIX C – REVISED CAMBRIDGE REFERENCE SEQUENCE1
DATE EFFECTIVE

VERSION

PAGE

04-08-2005

2.0

1 OF 1

Hypervariable Region I (HVI)
GGGAAGCAGA
ATCAACAACC
CCATGAATAT
TAGTACATAA
ATGCTTACAA
CACATCAACT
GATACCAACA
ATAAAGCCAT
CCTTCTCGTC

Hypervariable Region II (HVII)

1

ATGCACGCGA
CCTATGTCGC
ATTATTTATC
ACTTACTAAA
TAATAATAAC
CAGACATCAT
CCCGCTTCTG

TAGCATTGCG
AGTATCTGTC
GCACCTACGT
GTGTGTTAAT
AATTGAATGT
AACAAAAAAT
GCCACAGCAC

AGACGCTGGA GCCGGAGCAC
TTTGATTCCT GCCTCATCCT
TCAATATTAC AGGCGAACAT
TAATTAATGC TTGTAGGACA
CTGCACAGCC ACTTTCCACA
TTCCACCAAA CCCCCCCTCC
TTAAACAC- 340(end)
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73113153193233273313-

TTTGGGTACC ACCCAAGTAT
GCTATGTATT TCGTACATTA
TGTACGGTAC CATAAATACT
AAACCCAATC CACATCAAAA
GCAAGTACAG CAATCAACCC
GCAACTCCAA AGCCACCCCT
AACCTACCCA CCCTTAACAG
TTACCGTACA TAGCACATTA
CC -16365(end)

r

TTCTTTCATG
TGACTCACCC
CTGCCAGCCA
TGACCACCTG
CCCCCTCCCC
TCAACTATCA
CACCCACTAG
TACATAGTAC
CAGTCAAATC

di
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160241606416104161441618416224162641630416344-

Human Mitochondrial DNA Revised Cambridge Reference Sequence,
from http://www.gen.emory.edu/MITOMAP/mitoseq.html
LOCUS
HUMMTCG 16568 bp ds-DNA Circular PRI
27-Sept-2001
DEFINITION- Human mitochondrion, complete genome.
ACCESSION- This sequence is a modified version of the 2001 Revised Cambridge Reference Sequence (GenBank
#NC_001807, a derivation of #J01415)
SOURCE
Human placenta mitochondrial DNA
ORGANISM Mitochondrion Homo sapiens- Eukaryota; Animalia; Chordata; Vertebrata; Mammalia; Theria;
Eutheria; Primates; Haplorhini; Catarrhini; Hominidae.
REFRENCES
Anderson S, Bankier AT, Barrell BG, de Bruijn MH, Coulson AR, Drouin J, Eperon IC, Nierlich DP, Roe BA,
Sanger F, Schreier PH, Smith AJ, Staden R, Young IG. Sequence and organization of the human mitochondrial
genome Nature 1981; 290: 457-465. MEDLINE- 81173052 PUBMED-7219534
Andrews RM, Kubacka I, Chinnery PF, Lightowlers RN, Turnbull DM, Howell N. Reanalysis and revision of the
Cambridge reference sequence for human mitochondrial DNA. Nat. Genet. 1999; 23 (2): 147. MEDLINE99438386 PUBMED- 10508508
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Example:
*

# of
*
LA's

LA input
vol. (ul)

Misc.
vol. (ul)

Amp. Neg 1

0

0

0

Sample

1

5.4

1

Sample

# of
Gels

1

Gel
Value/4 ul

Comment

Water
(ul)

ExoSap-It (ul)

Template (ul)

0

9.2

3.0

Control

7.8

56

7.9

4.3

1/10 dil.

6.5

* LA = linear array analysis, currently only used for quality control purposes
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Calculations for Amplification Negative:
1. The amplification negative was run only once on a gel at the usual volume of 4 ul. The gel value was zero for
that sample, and a linear array was not run. Therefore, the analyst enters 1 into the “# of Gels” field and 0 each into
the “# of LA’s”, “LA input vol.”, “Misc vol.”, and “Gel value” fields.
2. The total remaining reaction volume is calculated by the spreadsheet to be 46 ul (50 ul starting volume minus 4 ul
used for gel analysis).
3. The amount of ExoSAP-IT required is calculated by the spreadsheet according to the following guideline: 1 ul of
ExoSAP-IT for every 5 ul of amplified product. Thus, the current reaction volume is divided by 5 (46/5) and the
spreadsheet enters 9.2 into the “ExoSAP-IT” field.
4. The amount of template to add to the cycle sequencing reaction is calculated by the spreadsheet. In this case, a
gel value of 0 instructs the program to enter the maximum volume amount of 3 ul into the template field. The
spreadsheet also enters “Control” into the comments field based on the 0 gel value.
5. Finally, the amount of water is calculated based on the previously calculated sample volume to make the total
volume quantity sufficient at 10.8 ul. This DNA/water mixture is now ready to be added to the cycle sequencing
reaction.
Calculations for Sample:
1. In this example, in addition to the first gel another gel was run using only 1 ul of amplified sample. This was
done since the result of the first gel was off-scale relative to the upper molecular mass gel standard. Also, 5.4 ul of
the sample was used for Linear Array analysis. The user inputs 1 into the “# of Gels” field since only 1 gel was run
at the usual volume of 4 ul. The user also inputs 1 into the “# of LA’s” field along with the volume of 5.4 (ul) used
for the Linear Array analysis into the “LA input vol.” field. To account for the additional 1 ul that was run on the
second gel, this volume is inputted into the “Misc. Vol.” field. Finally, the user inputs the gel value into the “Gel
Value” field. This field is based on the amount of sample DNA in a volume of 4 ul. In this case, the gel rerun
yielded a value of 14 ng/ul. This value is then corrected by the user and multiplied by 4 to yield the final value of
56.
2. The total reaction volume is calculated by the spreadsheet to be 39.6 ul, which is equal to the starting volume
minus 4 ul for the first gel, 5.4 ul used for the Linear Array, and 1 ul that was used for the second gel (50 - 4 - 5.4 - 1
= 39.6).
3. The amount of ExoSAP-IT required is then determined as before. The spreadsheet calculates that the reaction
requires 7.9 ul of ExoSAP-IT (39.6/5).
4. In calculating the amount of template required for the cycle sequencing reaction, the spreadsheet first determines
the new concentration of the DNA sample after addition of ExoSAP-IT by the dividing the original concentration
[(56 ng/4 ul)(39.6 ul)] by the new volume (47.5 ul). The new concentration (11.67 ng/ul) is then used to calculate
the volume of sample needed to equal 5 ng of sample DNA [(5 ng)/(11.67 ng/ul) = 0.428 ul]. If the final volume is
less than 1 ul, the spreadsheet will indicate that a dilution is necessary in the “Comment” filed. In this example, the
spreadsheet calculation indicates that 4.3 ul of a 1/10 sample dilution is required.
5. As before, the spreadsheet indicates the amount of water necessary to yield a total of 10.8 ul of sample volume
for the next step of cycle sequencing.
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